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Preface

Preface
This guide provides instructions about using AppEnhancer Web Access to create
and manage documents. For more information about hardware and software
requirements, see OpenText AppEnhancer Release Notes.
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Chapter 1

Getting Started

AppEnhancer Web Access enables you to create, index, retrieve, and manage
documents.

AppEnhancer Web Access uses security profiles. When you log in, the access
privileges and restrictions are in effect throughout the login session. The access
privileges that are granted to your user account control the documents that you can
access within AppEnhancer Web Access and the functionalities that are available
when you work with documents.

Understanding AppEnhancer concepts and terms can help you use this product
more effectively. For more information, see the OpenText AppEnhancer Administration
Guide.

1.1 Common features of AppEnhancer Web Access
AppEnhancer Web Access provides you with many functionalities to work with
content. These functionalities enable you to:

• Scan documents to create new or add to existing documents or batches, using
PixTools for Web.

• Add electronic files to the AppEnhancer repository as individual documents,
batches, and individual pages.

• Index documents by specifying information in the application-specific index
fields. Indexing enables you to organize, search, and retrieve documents
efficiently. You can also index batches that have been added to applications by
using other AppEnhancer products.

• Retrieve documents by using various search methods, such as index value
searches, multiple application searches, and document property searches. You
can also select documents to view, edit, and print, and you can email documents
and pages as attachments or links.

• Attach annotations or redactions to highlight important information, comment
on the contents of the page, or block areas of the page from view.

• Modify index field values and export document indexes.

• File documents for retention to protect them from accidental losses.
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1.2 Document storage and display
You can store any type of file in AppEnhancer. Depending on the type,
AppEnhancer stores files as supported or unsupported file types. When you capture
electronic files, AppEnhancer first verifies the file type, and then stores the file as the
identified type (such as image, text, foreign file format). The functions available are
file-type dependent. Features that are available with one file type might not be
available in another. Also, supported and unsupported files types are displayed in
different ways.

1.2.1 Supported files
The AppEnhancer Web Access Document Viewer displays the content of supported
file types. Natively supported file types include: text files, Computer Output to
Laser Disk (COLD) documents, Enterprise Report Management (ERM) files, image
files (JPEG, GIF, TIFF, Windows Bitmap, PCX, DCX, and TGA), Rich Text Format
(RTF) files, Hypertext Markup Language (HTML) files, Extensible Markup
Language (XML) files, and Adobe Portable Document Format (PDF) files.

You can add annotations to image, text, and PDF files, and you can process image
files and image-only PDF files by using Optical Character Recognition (OCR). (OCR
requires an optional purchase.) You can also print, email, and export these files.

Note: Non-image PDF and non-text PDF files will not be OCRed by the index
agent.

1.2.1.1 Image files

Image files are stored in common formats such as TIFF, JPEG, GIF, and Bitmap. The
Render Server renders all other image formats, including TIFF, into one of these
formats to enable proper display of image files in different platforms and browsers.

By default, AppEnhancer Web Access stores images in their native format (for
example, a TIFF file is stored as a TIFF file). It can also store image files in a different
format if AppEnhancer supports that format. When you store an image file in a
specific image format, AppEnhancer ignores the original format and stores all
images in the selected format.

Note: Progressive JPEG files are not supported. These files are imported as
foreign files.

Chapter 1   Getting Started
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1.2.1.2 COLD, ERM, and text files

COLD data is the report data that is generated from existing applications, which are
indexed by using an extraction process, and downloaded into AppEnhancer
applications. After the import, the files are stored in the compressed text file format
that is proprietary to AppEnhancer.

Form overlays that are added (from AppEnhancer Reports Management) to these
documents enable you to view the report data in the context of a standard form. You
cannot add form overlays to PDF documents from AppEnhancer Reports
Management. The Render Server renders COLD and ERM documents with form
overlays.

Note: Usually, text files display as text files; otherwise, they display as foreign
files. ASCII, EBCDIC, and EBCDIK are the supported text formats.

1.2.1.3 Rich Text Format, Hypertext Markup Language, and Extensible
Markup Language files

AppEnhancer stores RTF, HTML, and XML files as foreign files. A web page is
typically in HTML format. If you have access to the Index Agent for full-text
indexing, you can submit RTF and HTML files for full-text indexing.

1.2.1.4 Portable document format files

The Render Server renders PDF files as images.

You can add annotations to a PDF file and also perform functions such as printing,
exporting, and emailing.

If the software cannot extract text from a PDF file, the pages are processed for text
content by using OCR. If you have access to the Index Agent for full-text indexing,
you can submit PDF files for full-text indexing.

Note: Non-image PDF and non-text PDF files will not be OCRed by the index
agent.

1.2.2 Unsupported files
Unsupported files are stored in AppEnhancer in their native format and include
foreign files and Object Linking and Embedding (OLE) files.

1.2. Document storage and display
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1.2.2.1 Foreign files

When you import files that are not natively supported in AppEnhancer, it stores
them as foreign files, in their native file format.

Pages that are imported as foreign files are represented as a link. To view the
contents of the page and page information, first export the foreign file and then open
it in a third-party viewer. Annotation buttons, zoom controls, and the rotate function
are not available for foreign files.

You can perform functions such as printing, exporting, and emailing for foreign
files. If you have access to an Index Agent for full-text indexing, you can submit
foreign files to the Index Agent.

1.2.2.2 OLE objects

When you insert a file that is not supported as an object, through AppEnhancer
Document Manager, AppEnhancer uses OLE to embed the file. The OLE objects are
stored in their native file format. You can view only the page information of these
objects in AppEnhancer Web Access. You cannot submit OLE objects for full-text
indexing.

1.3 Operational modes
Your access to different functionalities also depends on the AppEnhancer
operational modes: check-in/check-out mode, normal mode, and reason audit mode.
For more information, see the OpenText AppEnhancer Administration Guide.

1.4 AppEnhancer Web Access Document Viewer
AppEnhancer Web Access Document Viewer is a cross-platform and cross-browser
compatible module of AppEnhancer Web Access. The viewer supports Microsoft
Internet Explorer, Microsoft Edge, Mozilla Firefox, Apple Safari, and Google
Chrome. It enables you to view images that are rendered by the Render Server.

1.4.1 Document types supported by Document Viewer
You can display the following document types in Document Viewer. These
document types are a subset of the supported document types that AppEnhancer
supports.

Document type Comments

Image Preset zoom ratios are provided. Annotation
viewing and editing are supported.

COLD Zoom ratios and color bars are supported.
You can configure font settings and color bar
settings in the User Settings page.
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Document type Comments

COLD with Text Form Overlay By default, displays the document as
specified in the User Settings page.
However, you can change the current view
of a document by turning the Text Form
Overlay option on or off from the Page menu
of the document. Color bars are not
supported when the TextForm Overlay
option is turned on.

COLD with Image Form Overlay COLD documents with the Image Form
Overlay option are rendered as image files
by the Render Server. You can turn the
Image Form Overlay option on and off from
the Page menu.

Foreign File Foreign files appear as links. You can
download the files by accessing the links.

PDF File You can view a PDF file either:

• As an image, which enables you to
perform annotations and zoom
operations

• In a new tab or inline in the viewer or a
new window of the browser , if the
browser can display PDF files in their
native format

Note: Not all documents automatically open in the Document Viewer. To view
a foreign file, such as a Word document, click the link in Document Viewer to
access the document in its native application or to render it so that it opens in
another window. For information about how to view foreign files within
Document Viewer, see “Viewing foreign files” on page 69.

1.5 Logging in to AppEnhancer Web Access
Provide credentials to log in to the default data source when you launch
AppEnhancer Web Access. The procedure to provide your credentials depends on
the security provider that is configured for the data source and the authentication
mode that is configured for AppEnhancer Web Access.

These security configurations are available:

• CM security

• Windows security

• Active Directory Federation Services (ADFS)

• Central Authentication Service (CAS)

• OpenText Directory Services (OTDS)

1.5. Logging in to AppEnhancer Web Access
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• SAML 2.0

For more information, see the OpenText AppEnhancer Administration Guide.

1.5.1 Logging in by using CM security configuration
1. Type the web address for AppEnhancer Web Access in a browser.

2. In the login dialog box, select the name of the data source from the list box.

3. Type your AppEnhancer login username and password in the corresponding
text boxes.

If you have not been assigned a username and password, contact the
AppEnhancer system administrator to obtain an AppEnhancer user account.

4. To enable the full-text search capability during the session, select Request Full-
Text Search Support.

After you select this option, the option remains enabled so that you have full-
text search support each time you log in. You can cancel this support, if
required.

Note: If your AppEnhancer user account does not include full-text
privileges, or if you have full-text privileges but the maximum number of
full-text licenses has been exceeded, the full-text criteria section does not
appear when you create or edit a search criterion.

5. Click SIGN IN. AppEnhancer Web Access displays a list of applications.

1.5.2 Logging in by using Windows security configuration
If the AppEnhancer system administrator has not enabled automatic login for
Windows security, log in to a Windows security data source in the same way that
you log in to a CM security data source.

The AppEnhancer system administrator can enable automatic login when
configuring Windows security. The system administrator can also request full-text
license support at the time of automatic login. For Internet Explorer or Chrome
browsers, the Windows security provider automatically authenticates users logging
in to AppEnhancer Web Access, without the need to go through the application
login dialog box. If the Windows account is invalid for the data source, the login
attempt fails.

Note: For the Firefox browser, or if the deployment is not configured for the
Internet Explorer or Chrome browsers, a dialog box prompts you for your
Windows credentials to log in to AppEnhancer Web Access.

For information about security configurations, see the OpenText AppEnhancer
Administration Guide.
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1.5.3 Logging in by using ADFS, CAS, OTDS, or SAML 2.0
ADFS, CAS, OTDS, and SAML 2.0 provide Single Sign-On (SSO) authentication
services. The AppEnhancer administrator must configure ADFS, CAS, OTDS, or
SAML 2.0 information in the web.config file to enable AppEnhancer Web Access to
support these authentication services. The ADFS, CAS, OTDS, or SAML 2.0 servers
must be configured to be able to return the user information to AppEnhancer Web
Access for validation. To enable validation, the user information must be added into
the AppEnhancer data source in advance.

1. Click the login button on the login page.

The web browser redirects you to the server login page.

2. Type your CAS, ADFS, OTDS, or SAML 2.0 server login user name and
password.

One of these events occurs:

• The server verifies the credentials, and, if found invalid, waits for you to
type the correct credentials.

• The server verifies the credentials, and, if found valid, redirects the browser
to AppEnhancer Web Access, along with the user information (login
credentials). AppEnhancer Web Access compares the user information with
the data available in the data source. If it finds a match, the AppEnhancer
Web Access home page appears.

• If AppEnhancer Web Access fails to find a matching record in the
AppEnhancer data source, it displays an error message and redirects you to
its login page. Try the SSO login again or log in using CM or Windows
credentials.

1.6 Switching between multiple data sources
After you log in to a data source, you can see the current data source name and your
login name on the title bar. If multiple data sources are available, you can select any
of the other available data sources within AppEnhancer Web Access. This feature
enables you to work with applications from two or more data sources during a
single session. You must have security rights to access the data sources.

To switch to another data source, select a data source from the list box next to the
data source name on the title bar. When you select a data source, one of these events
occurs:

• If you have already logged in to the selected data source, you are automatically
switched to it.

• If you have not yet logged in to the selected data source, the login dialog box
appears. The login depends on the security provider for the data source and the
authentication mode that is configured for AppEnhancer Web Access.

1.6. Switching between multiple data sources

EAXCORE230400-UGW-EN-1 User Guide 17



For information about logging in to a data source with CM, Windows, ADFS, and
CAS security configurations, see “Logging in to AppEnhancer Web Access”
on page 15.

1.7 Changing your password
At any time during the AppEnhancer Web Access session, you can change your
password for any active data source that is configured with CM security. When you
change your password for a data source, your AppEnhancer password for that data
source also changes.

Note: If the AppEnhancer administrator configures AppEnhancer by using the
Windows NT security model, you cannot change your password within
AppEnhancer Web Access. Instead, you can change your password by using
Windows NT. Your AppEnhancer/AppEnhancer Web Access password
automatically changes to the password you set by using Windows NT.

For more information, see the OpenText AppEnhancer Administration Guide.

To change the password for a data source:

1. In the Application List view, click your login name on the title bar and select
Change Password from the list box.

2. In the Change Password dialog box, type your current password and then a
new password.

3. To confirm the change, type the new password again.

4. Click CHANGE.

1.8 Application List view
The Application List view consists of a tree structure that lists the applications you
can access from the data source. When you click an application from the tree view
on the left, the list of queries that are configured for the application appears in the
right panel. You can create new queries and run existing queries for an application
from this view. The new and saved queries also appear under the respective
applications in the Application List view.
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1.9 Keyboard shortcuts
AppEnhancer Web Access includes keyboard shortcuts to perform certain functions,
such as uploading documents and batches, managing batches, and working within
documents. You can press the question mark key to display a menu that describes
the available keyboard shortcuts for the view.

The following table lists the available functions and keyboard shortcuts.

Function Shortcut

Print CTRL+ALT+P

Previous Document ALT+P

Next Document ALT+N

Close Document CTRL+ATL+Q

Next Page ALT+PAGE DOWN

Previous Page ALT+PAGE UP

Next Page Version ALT+SHIFT+PAGE DOWN

Previous Page Version ALT+SHIFT+PAGE UP

Open the Text Search Dialog Box CTRL+ALT+F

Select Index CTRL+ALT+U

Auto Index ALT+SHIFT+U

Key reference & Indexes CTRL+ALT+K

Apply Last Modified Index CTRL+ALT+L

Rotate Left ALT+L

Rotate Right ALT+R

Zoom In ALT+SHIFT

Zoom Out ALT+DOWN ARROW

Create a Straight Line Annotation SHIFT+L

Create a Freehand Line Annotation SHIFT+F

Create an Arrow Annotation SHIFT+A

Create a Rectangle Annotation SHIFT+R

Create a Rounded Rectangle Annotation SHIFT+N

Create an Oval Annotation SHIFT+O

Create a Highlight Annotation SHIFT+H

Create a Text Annotation SHIFT+T

Create a Stamp Annotation SHIFT+S

1.9. Keyboard shortcuts
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Function Shortcut

Open the Text Search Dialog Box CTRL+ALT+F

Rotate and Save - 90° Clockwise ALT+S+1

Rotate and Save - 180° Clockwise ALT+S+2

Rotate and Save - 270° Clockwise ALT+S+3

Scan CTRL+ALT+S

Select Scanner CTRL+ALT+C

1.10 Logging out of AppEnhancer Web Access
When you finish working with AppEnhancer Web Access, log out correctly to
ensure that the license assigned to you is available to another user.

To log out, click the Log Out icon on the right-most of the title bar.

If you logged in by using the SSO feature, click your login name on the title bar and
select SSO Logout from the list. You are now logged out of both AppEnhancer Web
Access and the external authentication server.

1.10.1 Automatic logout
The AppEnhancer system administrator can configure AppEnhancer Web Access to
enable automatic logout. If automatic logout is configured, you are automatically
logged out when you close the browser window.

Note: You are also automatically logged out when you perform a refresh or
type another address in the address bar. When you perform an automatic
logout, a pop-up window appears to send the logout request to the server. If
you have blocked the pop-up window in the browser setting, the automatic
logout function does not work.

1.10.2 Session expiration
If AppEnhancer Web Access remains in an inactive state longer than the predefined
period, your session expires. The system administrator configures this period. You
are redirected to the login page when you try to perform an operation. After
successful login, you can then perform the operation.

For more information, see the OpenText AppEnhancer Administration Guide.
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Chapter 2

Customizing Your System

User settings are configured at these two levels, each independent of the other:

• Data Source: Configure settings that belong to a data source.

• Application: Configure settings that belong a specific application.

Your configuration option settings are saved in the AppEnhancer server as part of
your user profile. Depending on the AppEnhancer security privileges that are
granted to your profile, you might not have access to, or be able to view, all the
options. These settings stay in effect for your AppEnhancer Web Access sessions,
regardless of which workstation you are working on or which browser type you use
to log in. You can change the configuration settings at any time to meet your
requirements.

For more information about configuring user profiles, see the OpenText AppEnhancer
Administration Guide.

2.1 Configuring data source user settings
1. Click your login name on the title bar and select User Settings.

2. In the Data Source tab of the User Settings page, specify the following details:

Section or field Description

Search/Result Set

Display Document in Separate Popup
Window

Opens each document in a separate
browser window.

Note: This setting applies only
when you open documents from the
Query Results page. It does not
affect document display during
batch import or document indexing.

Show Document ID Includes document IDs in the query
results.

Enable search by Document ID Allows to search for a document with the
document ID.

Show Previous Document Version Displays the previous document revisions
in the query results.
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Section or field Description

Document ID Sort Order Sets the sort order (the order in which a
result set is sorted and displayed, based on
the document ID) for documents in the
query results.

Query Results Page Size Limit Limits the number of results per page in
the query result. Type any number from 1
to 500.

Enable Document Properties Search Configures the search criteria page to
include document properties as well as
document index values.

Document Index Export Format Sets the format for exporting document
index values.

Enable Preview Thumbnails for Each
Document in Query Results

Enables you to specify whether to preview
thumbnails for each document in query
results.

Page Index of Preview Thumbnail Sets which page will be used in thumbnail
preview.

Document View

Prompt for Checkout Prompts you to check out the document
when you open it from the Query Results
page.

Show Page Thumbnails Displays page thumbnails for an open
document.

Enable Inline Rendering of Foreign Files Enables HTML export of foreign files on
the server side.

Use Browser to Display PDF Files Provides a link to view the PDF files in a
new browser tab or window if the browser
can display PDF files in their native
format. You can also install Adobe
Acrobat Reader to view PDF files.

Use Browser to Display Secured PDF Files Provides a link to view the secured PDF
files in a new browser tab or window if the
browser can display PDF files in their
native format. You can also install Adobe
Acrobat Reader to view PDF files.

Enable Inline Viewing of PDF Files Enable inline viewing of PDF files inline in
Viewer instead of a PDF file link while
using a browser to display PDF files or
secured PDF files.

View Native Images Display Bitmap, GIF, JPEG, PNG images
in Viewer in native format without Render
Server capability.
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Section or field Description

The Number of Pages to Pre-render Set the number of pages to pre-render
after current page is loaded. Its valid value
is from 0 to 5 and its default value is 3.
Sets 0 means turns off pre-render function.

Thumbnail Number Limit Limits the number of thumbnails for a
document to help improve rendering
performance.

Open Office Documents with Office
Online Server

Enables viewing and editing Microsoft
Office Documents using Office Online
Server (OOS).

Display DPI for Image/PDF file in Viewer Sets the display DPI of PDF and Image
files in the viewer. The value range is
72-999. The default value (-1) is the
original DPI. This option can be
configured by the administrator only.

Automatic Displaying DPI Renders images using dynamic DPI
scaling to improve rendering server
performance. When this option is enabled,
the DPI value set in Display DPI for
Image/PDF file in Viewer is ignored.

Note: If you do not encounter
performance issues while rendering,
this option should be disabled.

Index

Show Index View Enables you to specify whether to display
index fields for an open document.

Check for Matching Index When you index a new document, checks
for duplicate index entries for documents
in the current application and provides an
error message if a matching index is
found.

Enable Dual Data Entry Enables you to set dual data entry as the
required method for entering document
indexes. Selected by default.

Ignore Date Stamp Ignores the date stamp field for the
matching index check.

Index Results Page Size Limit Limits the number of indexes displayed on
a page.

Import

Display Batch in Separate Popup Window Opens the batch in a separate window.

Enable Scanning Scan feature can create a new document or
a new batch. It can also scan documents
into an existing document or batch.

2.1. Configuring data source user settings
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Section or field Description

Scan File Type Sets the scanned file format to AutoDetect,
TIFF, JPEG, PDF, or PNG.

Scan Feed Mode Sets the scan feed mode to Auto or Single.

Import Email Attachment as New Page When importing email (.msg) to
AppEnhancer, the attachment(s) will be
split as new page(s) in the document.

Start New Document from a temporary
Batch

Create a document from batch (legacy way
by default) or new document directly.

Inspect PDF File Performs a scan of the PDF file to check for
any errors. If errors are found, the import
process will fail.

Decrypt PDF File When importing PDF files, all encrypted
files are automatically decrypted and
saved as a regular PDF.

PDF Portfolio Import Options Sets the import settings for PDF Portfolio
files. You can choose from No Detect, As
Foreign File, or Extract Embedded Files.
No Detect indicates that the application
does not attempt to identify PDF Portfolio
files. This is the default option. As Foreign
File indicates that portfolio files are
maintained as foreign files and to view a
file, users must first download it before
opening it in a PDF viewer. Extract
Embedded Files indicates that all
embedded files are extracted from the
portfolio file and imported as separate
pages before the original PDF portfolio file
is deleted.

Export

Use PDF Format if Possible Exports documents in the PDF format, if
applicable.

Note: If you select this option, you
cannot set the image format for
black and white, 4-bit and 8-bit
color, and true-color images.

Black and White Images Sets the image format for black and white
images. Available values are: Windows
BMP, TIFF, and Compressed TIFF.

4-bit or 8-bit Color Images Sets the image format for 4-bit or 8-bit
color images. Available values are:
Windows BMP, Compressed Windows
BMP, GIF, TIFF, and Compressed TIFF.
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Section or field Description

True-Color Images Sets the image format for true-color
images. Available values are: Windows
BMP, GIF, JPEG, TIFF, and Compressed
TIFF.

JPEG Quality Factor Sets the quality factor when you select
JPEG as the True Color Image format.
Type any number from 1 to 100.

PDF Sets the PDF file export format to PDF or
image.

Text Specifies whether you want to export
textual data as text or as an image.

Use Multipage Files Enables the export of multipage
documents.

Export in Archived Format Specifies that the original file type is
maintained during the export process.
Typically, when files are exported, they
are converted to the format specified by
the export configuration settings. File type
conversion is most common when
working with image files.

COLD Form Overlay for Export Sets the type of COLD overlay you want to
use when you export documents.
Available values are: None, Text, and
Image.

Merge Selected Documents into One Combines the selected documents from a
query results list into a single document.

COLD

Default View COLD Form Overlay Specifies the type of COLD overlay to use
when you open documents. Available
values are: None, Text, and Image.

Show Color Bars Turns on the color view.

Color Bar Lines (1-6) Sets the width of color bar bands. Use a
number from 1 to 6. The default is 3.

Color Bar Color Sets the color that is used for the color bar
bands.

When you view documents in
AppEnhancer Web Access Document
Viewer, the background is composed of
alternating bars of a selected color and
white.

Text Font Name Sets the name of the font to use for text
data.

2.1. Configuring data source user settings

EAXCORE230400-UGW-EN-1 User Guide 25



Section or field Description

Text Font Size Sets the point size to use for the selected
font. This is a required field. Type a font
size from 6 points to 24 points.

Text Font Bold Displays text in bold typeface.

Text Font Italic Displays text in italic typeface.

Print

COLD Form Overlay for Print Sets the type of COLD overlay you want to
use when you print documents. Available
values are: None, Text, and Image.

Endorse Printed Pages Configures printing so that printed
documents are endorsed.

For more information, see “Using the
Endorsement feature” on page 29.

Endorsement Position Sets the endorsement position, if you
select Endorse Printed Pages. Available
values are: LeftTop, LeftBottom, RightTop,
and RightBottom.

Endorsement Text (Maximum of 70
characters)

Specifies the text to appear in an
endorsement, if you select Endorse
Printed Pages. This field also supports
predefined macros. You can type up to 70
characters, including spaces.

Page Fetch Retry Enabled If an error occurs, sets the application to
continue its attempts to retrieve a page as
many times as you specify in the Page
Fetch Retry Count field. Selected by
default.

Page Fetch Retry Count (1-10) Sets the number of attempts that the
application makes to retrieve a page if an
error occurs. Applicable only if you select
Page Fetch Retry Enabled.

Show Print Log Displays the log when the print operation
ends.

Email

Use PDF Format if Possible Sets the format for email attachments to
PDF.

Use XPS Format if Possible Sets the format for email attachments to
XPS.

Note: You can choose either the PDF
or XPS format. If you select these
options, you cannot set the image
format for black and white, 4-bit and
8-bit color, and true-color images.
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Section or field Description

Black and White Images Sets the image format for black and white
images. Available values are: TIFF,
Windows BMP, and Compressed TIFF.

4-bit or 8-bit Color Images Sets the image format for 4-bit or 8-bit
color images. Available values are:
Windows BMP, Compressed Windows
BMP, GIF, TIFF, and Compressed TIFF.

True-Color Images Sets the image format for true color
images. Available values are: Windows
BMP, GIF, JPEG, TIFF, and Compressed
TIFF.

JPEG Quality Factor Sets the quality factor when you select
JPEG as the True Color Image format.

COLD Form Overlay for Email Sets the type of COLD overlay you want to
use when you email documents. Available
values are: None, Text, and Image.

PDF Sets the PDF file format to PDF or image
when sending the file as an email
attachment.

Display Text as Indicates the display of textual data as text
or image. Image is selected by default.

Use Archive File Format Enables you to use the archive file format
for email messages.

Use Multipage Files Enables you to email multipage
documents. Selected by default.

Send Attachments as Hyperlinks Enables you to use hyperlinks for email
attachments. Selected by default.

Merge Selected Documents into One Combines the selected documents from a
query results list into a single document.

Mail Message Format Specifies the format for email messages.
HTML is selected by default.

Client Email Format Specifies the format for email messages
that are saved to the desktop client. MSG
is selected by default.

Registered Mail Address Specifies the default mail address of a
user. This option can be configured by the
administrator only.

Full-text

2.1. Configuring data source user settings
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Section or field Description

Enable Full-Text Search Configures the search criteria page for full-
text search. The option is selected by
default.

Select Request Full-Text Search Support
on the login page when you log in to a
data source to enable this feature.

Note: Disabling this option does not
release the full-text license that was
assigned to you when you logged in
to AppEnhancer Web Access.

Thesaurus During queries, includes a thesaurus
search for words that are related to the
search criteria.

OCR Language Sets the default language to submit
documents for OCR indexing.

Prompt Submitting Full-Text Index/OCR
Dialog

If selected, each time you submit
documents for full-text or OCR indexing, a
dialog box appears to enable you to select
an OCR language from a list box.

If not selected, no dialog box appears. The
value set in the OCR Language field is the
default.

Others

Show Checked Out Documents in Home
Page

Allows user to specify whether to show
currently checked out documents in home
page.

Only Show Recently Created Documents
by Current User

Shows only the recently created
documents by the current logged in user
in the application page.

Job Manager (only in Administrator) Maximum Count of Backend Print/Export/
Email Job – When enabled, changes long-
running print/export/email jobs to the
backend from the Web Access UI. It
improves user experience by allowing
other Web Access operations
simultaneously. This item defines the
maximum job count of a user.

3. Click SAVE.
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2.2 Configuring user settings for an application
1. Click your login name on the title bar and select User Settings.

2. Select the Application tab of the User Settings page.

3. From the list of applications, select an application that you want to configure.

4. From the list of index fields for the selected application, select a value to
designate as the title of all documents that belong to the application.

5. Click SAVE.

2.2.1 Using the Endorsement feature
To print documents with an endorsement message in one corner, select Endorse
Printed Pages and type the message in the Endorsement Text field.

The endorsement feature supports these predefined macros:

Macro Output

%DS Displays the short form of the date, such as
3/2/2016, on which the page is printed.

%DL Displays the long form of the date, such as
Friday, March 02, 2016, on which the page is
printed.

%T Displays the time when the page is printed.

%DT Displays the document title.

%U Displays the user who printed the page.

%P Displays the current page number.

%DC Displays the total page count of document
pages.

AppEnhancer prints the endorsement on every page in the location that you have
selected from the Endorsement Position list box. The location of the macro output in
the endorsement depends on the location of the macro in the text string.

2.2. Configuring user settings for an application
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Chapter 3

Creating Documents

AppEnhancer Web Access enables you to store and organize many types of
information as documents. The documents are organized in applications for easy
retrieval. Authorized users can scan or upload electronically formatted files into
AppEnhancer Web Access. An AppEnhancer document can contain one or more
electronically formatted files. A document can have one or more sets of indexes that
you can use to search for the document.

3.1 Enabling the scanner
Before scanning any documents, the scanner must be enabled.

1. Click <User Name > User Settings in the upper right corner.

2. In the left side list, click Import, and then check the box for Enable Scanning.

3. Click Save.

3.2 Configuring the scanner
Scanners can be configured from the AppEnhancer Web Access application.

1. Click the plus (+) symbol in the upper right corner, then New Document.

2. Click the Select Scanner icon.

3. Select the scanner you want to configure from the list presented and click OK.

4. Click the down arrow beside the Select Scanner icon to configure the settings.
You can also click the Settings icon and open the Advanced Settings dialog for
more configuration options.

3.3 Importing and scanning documents
1. Select the application that you want to add a document to.

2. Perform either step:

a. Click the  icon in the toolbar and select New Document or click the
NEW DOCUMENT button.

b. Drag and drop the electronic file or files from your desktop into the main
panel.

Note: If you enabled the thumbnails view in the User Settings page,
you can also drag and drop the electronic file or files from your
desktop into the thumbnails view.
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Drag and drop files to the inline render frame of a foreign file to add
pages is not supported, but you can drag files to the outside area of
the frame, such as the thumbnail.

3. A blank document is created. You can browse and select one or more files or
scan the page(s) to the document. If you enabled the thumbnails view in the
User Settings page, you can use the page thumbnails that appear on the left to
navigate through the pages.

If you have selected more than one file, the pages are appended sequentially.

4. If you checked the user setting Start New Document from a temporary Batch
under Import, you can choose whether you want to index the document now or
later:

• To index immediately after the upload, specify relevant values in the index
fields that are available for the selected application, and then click SAVE.

• To continue without indexing, click CANCEL.

A message indicates that the document is not indexed. Click DELETE to
delete the unindexed document or KEEP to continue without deletion. The
document is added to the Uploaded Batches list as a temporary batch to be
indexed later. By default, the document is saved with a name that includes
your login ID and the date and time you uploaded the document. For
example, SYSOP - 8/1/2015 7:02:01 PM.

For more information, see “Indexing batches manually” on page 39.

Note: When applying the default import setting (un-check Start New
Document from a temporary Batch), an imported file will be lost if the user
creates a new document without saving the index. If the user setting Start New
Document from a temporary Batch under the.Import category is checked, the
unsaved document will be kept as batch in the same application.

3.4 Creating documents in batches
In addition to adding documents individually, AppEnhancer Web Access enables
you to create and index documents in batches.

Note: If you enabled Display Batch in Separate Popup Windows under Index
in the User Settings page, the batch index opens in a pop-up window. This
occurs when you create a new document or a new batch, or drag and drop files
to create a new document or a new batch.
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3.4.1 Uploading batches
1. Select the application that you want to add a document to.

2. Click the  icon in the toolbar and select New Batch from the list box or click
the NEW BATCH button on the application home page.

3. In the New Batch dialog box, specify the following details:

Field Description

Application The name of the AppEnhancer application
that you want to upload the batch into.
The name of the selected application
appears by default. You can select a
different application from the list box.

Name A name for the batch.

Batch Security Security settings for the batch.

Description Any specific comment, if required.

4. Click CONTINUE. A blank batch is created. You can browse and select one or
more files or scan the page(s) to the batch. If you have selected more than one
file, the pages are appended sequentially. The batch is added to the Uploaded
Batches list and is available for indexing. You can continue to add more files to
the batch after is it created.

For more information, see “Adding pages to batches” on page 35.

Note: You must have the Batch Scan privilege to upload batches.

3.4.2 Working with batch lists
The Manage Batches page lists the batches and documents that are uploaded into an
application. To access this page, click the  icon in the toolbar and select Manage
Batches. This page provides options to index and manage batches. If batches exist
for the selected application, information about those batches appears in the list.

The following information appears about each batch or document:

Column Description

Name The name of the batch.

Description The description of the batch, if any.

Create Time The date and time the batch was uploaded
into AppEnhancer.

Created By The name of the user who uploaded the
batch into AppEnhancer.

Owner The assigned owner of the batch.
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EAXCORE230400-UGW-EN-1 User Guide 33



Column Description

Pages The number of pages in the batch.

State The status of the batch (Idle, Indexing, or
Scanning).

3.4.2.1 Batch list menu and toolbar options

When you select a batch or document from the Uploaded Batches list, a toolbar
appears with these options:

Option Description

FORCE DELETE Deletes the selected batches. Batches must be
in the idle state for you to be able to delete
them. When a confirmation message appears,
click DELETE to proceed with deletion.

RESET TO IDLE Resets the status of the selected batches (in
scanning or indexing states) to Idle.

The status of a batch is shown in the State column of the Uploaded Batches list.
Batches can be in one of these states: Indexing, Scanning, and Idle. If a user working
with a batch closes the browser without logging out, the batch is listed as being in
the Indexing state, although no one is indexing the batch. The Scanning state
indicates that another user is importing pages into the batch.

The context menu enables you to perform operations at a single batch or document
level. Select a document and click the adjacent down-arrow icon to view the context
menu.

Option Description

Index Indexes a document or batch from the list.
When you open documents to index them,
the batch status changes from Idle to
Indexing.

Import Adds pages to batches. When you open
documents to import pages, the batch status
changes from Idle to Scanning.

Edit Changes the name of the batch. When you
click EDIT, the Batch Information dialog
box appears where you can specify the new
name, batch security permissions, and
description for the batch.
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Option Description

Change Owner Changes the batch owner. You can use this
option if you have administrator permissions
in an application. When you click Change
Owner, the Batch Owner dialog box appears
where you can specify the new batch owner’s
name and batch security permissions. You
can select a single user or a group as the
batch owner.

3.4.2.1.1 Unlocking batches

For other users to work with the batch, a user with AppEnhancer Administrator
privileges must unlock the batch. To unlock batches that are in the Indexing and
Scanning states, click RESET TO IDLE on the toolbar to change the batch status to
Idle. Unlocked batches are in the Idle state and available for use.

Note: If you must unlock a batch but do not have the Administrator privilege,
contact the system administrator.

3.4.2.1.2 Refreshing the uploaded batches list

To refresh the Uploaded Batches list, click the refresh icon on the toolbar.

3.4.3 Managing batches
AppEnhancer Web Access provides several ways to manage batches. You can add
pages to AppEnhancer documents or batches. The pages can be of the same object
type or of a different object type. You can also switch between different states, move
or copy pages, delete batches or batch pages, and so on.

Note: If you enabled Display Batch in Separate Popup Windows under Index
in the User Settings page so that the batch index opens in a pop-up window,
ensure that you click the Close Window icon to close the batch. Otherwise, the
batch lock is not released until the session expires.

3.4.3.1 Adding pages to batches

1. From the Uploaded Batches list, select a batch, and then click Import on the
context menu.

The first page of the selected batch appears in the Document Viewer. The
Uploaded Batches list displays the status of the batch as Scanning.

2. Perform either step:

a. Click the Add Page icon on the Page toolbar. In the Add New Page dialog
box, select the file that you want to add and then click UPLOAD.

b. Drag and drop the electronic file or files from your desktop into the main
panel.

3.4. Creating documents in batches
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The files are appended to the end of the current document. The page
thumbnails also appear in the appropriate location.

3.4.3.2 Switching between importing and indexing states

You can switch between the importing (scanning) and indexing states when adding
(importing) pages to a batch. The batch is in the Scanning state during an import. To
switch to the Indexing state, click the New Document icon on the Batch toolbar. To
switch back to the Scanning state, click CANCEL on the index panel on the right.

3.4.3.3 Copying or moving batch pages

AppEnhancer Web Access enables you to copy or move batch pages between
AppEnhancer applications. It processes the pages as a new batch in the target
application. You must have the Batch Scan privilege for the target application to
copy and move batch pages.

1. From the Uploaded Batches list, select a batch, and then click Import on the
context menu.

The selected batch opens in the Document Viewer.

2. Click the Copy Move Pages icon on the Batch toolbar.

3. In the Copy or Move Pages to New Batch dialog box, specify the following:

Field Description

Document Pages The page number of the batch pages you
want to move or copy.

To specify a continuous page range, insert
a hyphen between the first and last page.
Example: 1-4.

To specify separate pages, insert a comma
between each page. Example: 2,4.

Target Application The application to which you want to
move or copy the pages.

Batch Name The name of the batch.

Batch Security Security settings for the batch.

Index New Document Indexes the batch immediately after
copying or moving the pages. If you do
not select this option, select the batch from
the Uploaded Batches list when you are
ready to index the batch.

4. Click MOVE if you want to move the selected batch pages from the source
application.

5. Click COPY if you want to leave a copy of the batch pages in the source
application.
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Note: You can copy or move pages only within a document. The page can
have text or images.

3.5 Indexing
After you upload an electronic file or a set of electronic files into AppEnhancer
applications, you must index the files and the individual files in each batch to save
them as AppEnhancer documents. Authorized users can use the index data to
retrieve them from the AppEnhancer database.

3.5.1 AppEnhancer document indexes
The AppEnhancer system administrator specifies the data that is required to retrieve
documents that belong to a particular application. This set of data is known as the
index of the document. Different applications have different types of index data.

The administrator can also configure the index fields for dual data entry so that an
index field has two input fields instead of one. The information that you type in both
fields must match. If it does not, an error message appears when you try to save the
index. Dual data entry provides data validation when you specify index information
during document creation.

Note: You have the option to change the dual data entry configuration that the
administrator has defined. You can change this setting when you define a
profile in the User Settings page.

3.5.2 Indexing types
The AppEnhancer administrator sets up index fields and specifies their
characteristics when creating and configuring an application. The indexing options
depend on whether the selected application is configured for automatic or manual
indexing.

3.5.2.1 Manual indexing

During manual indexing, you can specify the values for the index fields one at a
time, select an existing index record, or copy the index data of another document
and paste them into the relevant index fields of the current document.

For batch pages, you have two options:

• Select an existing document index and append the batch pages to the
corresponding document.

• Copy an existing index to create new AppEnhancer documents.

3.5. Indexing
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3.5.2.2 Auto indexing

You can use the Auto Index function to specify data in one or more index fields. You
can click the auto index icon on the top left of index panel and it will find a match,
select the data from the record in the Auto Index table.

Note: If the AppEnhancer system administrator configures to retain the Auto
Index record, the record remains in the table, even after you select it.

For instructions, see “Using the Auto Index feature” on page 43.

3.5.2.3 Key Reference indexing

The Key Reference indexing feature operates similarly to automatic indexing. The
Key Reference feature is useful for automatically populating the index information,
changing the index information frequently, or both.

Note: When you modify document indexes that are created by using the Key
Reference feature, updating index field data on one document might
automatically update data in the same field on other documents with the same
key index value.

• When you modify a data field value on an existing index record,
AppEnhancer finds all index records with the same key value and makes the
same change to those records.

• When you modify the key field value on an existing index record,
AppEnhancer modifies only that document; all other documents having the
original key value remain unchanged.

Example 3-1: Key Field Versus Data Field

Assume that for the HR application, the AppEnhancer system administrator
has configured Employee ID as the key field and Employee Last Name as a data
field. If you modify the Employee ID field for an index record, the other
documents with the same employee ID are not affected. However, if you
modify the Employee Last Name, the value changes in all other documents with
the same Employee ID.

Note: The Auto Index or Key Reference functionalities are available for indexing
only if the AppEnhancer system administrator configures the AppEnhancer
applications with fields enabled for Auto Index or Key Reference.

For more information, see “Using the Auto Index feature” on page 43 and “Using
the Key Reference feature” on page 43.
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3.5.3 Indexing batches manually
You can index batches when you upload them, or later, by selecting the batches from
the list of uploaded batches for an application.

1. Depending on when you decide to index a document, perform one of the
following:

a. To index a document immediately after you upload it, click the New
Document icon on the Batch toolbar.

b. To index a document from the list of uploaded batches:

i. Select the relevant application.
ii. Click the  icon and select Manage Batches.

On the Manage Batches page, you can view the list of Uploaded
Batches for the selected application. The batch state indicates the status
of the batch. Batches that are available for indexing show a status of
Idle. When a batch is selected for indexing, its status automatically
changes to Indexing.

iii. Select a batch from the list and then click Index on the context menu.

Note: The batch state automatically changes from Idle to
Indexing (you can view the state in the Uploaded Batches list).
This state prevents other users from accessing the batch.

2. For the first page that appears in the Document Viewer, type the appropriate
information from the document into each index field.

You can also use the Select Index option to populate the index fields. For
instructions, see “Using the existing index data” on page 42.

Note: It is recommended that you populate all the fields for which data is
available to make the document index as complete as possible.

To clear the index information and retype new data in the fields, if required,
click the Clear Index icon on the index panel toolbar.

3. After you finish providing the relevant data, click SAVE.

Notes

• If you have indexed a document, all the pages in the document inherit
the index data. The AppEnhancer repository stores the electronic file
and its index information.

• If you have indexed a batch, the current page is indexed and saved as a
new AppEnhancer document, and the next page in the batch appears in
the Document Viewer. You can attach more batch pages to this
document or create a new AppEnhancer document to index the
remaining pages.
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You can modify the index data after the Save operation, if required. Click MODIFY
to edit the index fields. Modify the values in the index fields as necessary, or use the
Select Index feature or the Copy/Paste Index option to use an existing index data.

For more information, see “Using the existing index data” on page 42 and
“Additional operations for a batch” on page 41.

3.5.3.1 Attaching batch pages to documents

Attaching batch pages to the current AppEnhancer document enables you to index
the rest of the pages without having to reenter the index information.

If only a few batch pages are part of the current document, you can attach the
additional pages one page at a time. If all pages are part of the current document,
you can attach all the pages simultaneously.

To attach the current page to the current AppEnhancer document:

1. From the Page toolbar, click the Attach Current Page icon.

The current page is removed from the batch and appended to the current
AppEnhancer document. The next page in the batch appears in the viewer.

2. Repeat step 1 to attach additional pages to the current document.

3. After attaching the last batch page that belongs to the current document, click
the New Document icon to create a new AppEnhancer document for indexing
the remaining pages.

4. Type the necessary information in the index fields and click SAVE.

AppEnhancer Web Access saves the indexed page as a new AppEnhancer
document. You can continue to attach more pages to this document or create
another document. If there are no more pages in the batch, a message indicates
that all the batch pages have been indexed.

5. Select the next operation from the message dialog box.

To attach all batch pages to the current document:

1. Perform either step:

a. From the Page toolbar, click the Attach All Pages icon.

b. Drag and drop the electronic file or files from the thumbnail panel.

All the remaining batch pages are attached to the current AppEnhancer
document, and the document is saved.

A message appears that indicates all the batch pages have been indexed.

2. Select the next operation from the message dialog box.
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3.5.3.2 Additional operations for a batch

During batch indexing, you can use the toolbar options to perform additional
operations.

Option Operation

Show/Hide Thumbnail

Shows or hide the thumbnails view when
multiple pages are present

Cancel Indexing

Cancels batch indexing

Scan

Scan documents and append them to the
current document or batch.

Scanner

Select a scanner. After a scanner is selected,
users can set the basic settings or the
advanced settings of the scanner.

New Document

Creates a new document

Last Indexed Document

Opens the last indexed document

Delete Batch

Deletes a batch

Delete Page

Deletes a page from the batch

Copy Index

Copies the current index data

Paste Index

Pastes the copied index data

Last Modified Indexes

Copies the information from the last
modified index into the fields of the current
page

New Index

Creates new index data for a document

Note: This option is available only if
the AppEnhancer administrator has
selected the Multiple indexes
referencing a single document option
for an application.
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Option Operation

Close Window

Closes the browser window if you enabled
the Display Batch in Separate Popup
Window under Index in the User Settings
page.

3.5.4 Using the existing index data
The Select Index feature enables you to search for and use the existing index
information when you are indexing document or batch pages. When you select an
existing index, you can either attach the current batch page to the AppEnhancer
document to which the selected index belongs or create a new AppEnhancer
document by using the same index data.

1. Click the Select Index icon on the index toolbar.

2. From the Select Index dialog box, click the record whose index data you want
to copy.

3. Perform one of the following:

a. To create a new document, click SELECT and then click SAVE in the index
panel.

If you have indexed a document, all the pages inherit the index data and
are saved as a single AppEnhancer document. For a batch, only the current
page is indexed and saved as a new AppEnhancer document. For more
information, see “Indexing batches manually” on page 39.

b. To append the batch pages to the existing AppEnhancer document, click
ATTACH.

If you have indexed a document, all the pages inherit the index data and
are appended to the existing AppEnhancer document. For a batch, only the
current page is indexed to the existing AppEnhancer document. You can
continue to attach additional pages or create a new document to index the
remaining pages. For more information, see “Attaching batch pages to
documents” on page 40.

3.5.5 Selecting a task after batch indexing
When you index and save the last page in a batch, AppEnhancer Web Access
automatically exits the batch indexing mode and displays a message that indicates
that all batch pages have been indexed.

In addition to the message, the dialog box also provides options to perform the
following tasks:

• Index another batch

• Import a new batch
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• Return to the Application List page

• View the most recently indexed document

• Log out of AppEnhancer Web Access

3.5.6 Using the Auto Index feature
1. From the list of applications, select the required application, click the  icon

in the toolbar, and then select Manage Batches.

In the Manage Batches page, you can view the list of Uploaded Batches for the
selected application.

2. Select a document or a batch from the list and then click Index on the context
menu. The first page in the batch appears in the Document Viewer.

3. Specify adequate index data to limit the number of matches from the Auto
Index table to one or few records.

4. Click the Auto Index icon on the index toolbar.

Note: If you do not specify any data, AppEnhancer Web Access retrieves
all the records from the auto index table.

5. From the Auto Index Result dialog box, click the record whose index
information you want to use, and then click SELECT.

The index fields are populated with data from the selected Auto Index record. If
only one matching record is found, AppEnhancer Web Access populates the
remaining index fields with the relevant data. If no matching records are found,
an error message appears.

If you want to delete document indexes from the Auto Index Result dialog box,
highlight the relevant records and then click the Delete icon.

6. Click SAVE.

After the Save operation, you can modify the index data, if required.

3.5.7 Using the Key Reference feature
1. From the list of applications, select the required application, click the  icon

in the toolbar, and then select Manage Batches.

In the Manage Batches page, you can view the list of Uploaded Batches for the
selected application.

2. Select a document or a batch from the list and then click Index on the context
menu. The first page in the batch appears in the Document Viewer.

3. Specify a value in the key index field, and then press the Tab key.

AppEnhancer Web Access retrieves the data from the Key Reference table and
populates the remaining index fields. No action occurs if a matching key
reference value is not found.
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4. Click SAVE.

3.6 Full-text indexing
Full-text indexing makes AppEnhancer Web Access documents retrievable by using
a full-text query.

3.6.1 Full text indexing in AppEnhancer Index Agent
You can submit selected documents from query results to a full-text queue on the
AppEnhancer Index Agent. After a document has been indexed, you can search for
the document by using words within the document text.

The AppEnhancer system administrator configures the full-text engine information
in AppEnhancer Administrator and AppEnhancer Index Agent. At least one full-text
queue must be active to submit documents for indexing. New documents can be
automatically submitted for full-text indexing.

If you have Administrator and Full Text permissions, you can submit all documents
in an application for full text indexing.

1. From the list of applications, select the required application.

2. Click the  icon, and then click Full Text Index.

3. On the Options page, select the options and click Next.

4. On the Search Documents page, input the search query criteria for the
documents you would like to process and click Next.

The wizard displays the query results on the Select Documents page.

5. Select the documents that you would like to process. You can select the Process
selected documents option to manually select the documents from the list or
select the Process all documents found option to automatically process all the
query results. When you are finished, click Run.

The Process Result page appears.

6. Click Finish to exit the wizard or click Restart to process additional documents.
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Chapter 4

Retrieving Documents

AppEnhancer Web Access provides a variety of robust search and retrieval methods
that include search by index, search by wildcard, search by a list of values,
expression search, full-text search, and combination search.

If the Document Properties Search is enabled, you can also search for document
properties such as the name of the author, date, and keywords. You can even
combine search options to retrieve the most relevant documents.

The AppEnhancer Index Agent, an add-on module for AppEnhancer, supports full-
text indexing. This enables you to run searches that are based on full-text data. If you
have a full-text license and full-text permission, the Search Criteria page appears
with the Full-Text Search Criteria section whether you have full-text data or not.
The AppEnhancer Index Agent uses the xPlore full-text engine to submit documents
to the full-text database. The xPlore full-text engine enables you to perform queries
that are based on a thesaurus as well. Queries can also include both the index and the
full-text search values.

Note: The full-text search feature is enabled if you select the Request Full-Text
Search Support option on the login page.

If you have the Report View privilege, in addition to searching applications for
documents, you can also query the applications for reports that are generated by
AppEnhancer Reports Management.

For more information, see “Viewing AppEnhancer Reports Management reports”
on page 69.

After you retrieve a document, you can view, print, annotate, add and delete pages
or documents, and modify index and document properties.

4.1 Query functionality
You can search either one application or across multiple applications
simultaneously, if the applications reside within the same data source. The query
functionality enables you to create a new query, edit an existing query, and run a
query. Saved queries appear under the application to which they belong.
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4.2 Single-application searches
AppEnhancer Web Access enables you to use several different methods to set search
criteria for searching a single application.

4.2.1 Creating queries
1. From the list of applications, select the required application.

2. Click New Query.

3. In the New Search page, specify the search criteria by using the index fields and
other available options.

Note: For more information, see “Using advanced index value search
criteria” on page 47.

4. Select Include previous document revisions, if you want the search to retrieve
both current and previous versions of documents that meet the search criteria.

Note: This option is automatically checked if you selected Show Previous
Document Version under Search/Result Set in the User Settings page. If
you clear this selected option, the specification in the profile settings is not
affected.

5. Click the type of documents to display in the search results using the Active
documents, Recycled documents, and All documents options. (These options
are only available to users with the Recycle Bin Delete permissions.)

Tip: To view all contents of the Recycle Bin, run a query with no search
criteria and the Include previous document revisions and Recycled
documents options selected.

6. Perform one of the following actions:

• Click RUN to run the query without saving it for future use.

• Click SAVE to be able to run the query at any time.

1. In the Save Search dialog box, specify a name for the query.

2. Select Available to all users to share the query with other users (public
query).

If you do not select this option, the query is considered a private query
that only you and the users with the Administrator privilege can access.

3. Click SAVE.

The query is saved under the relevant application and in the navigation
panel. You can click a saved query in the navigation panel to execute the
query.
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4.2.1.1 Using advanced index value search criteria

In addition to specifying index values for a basic index name search, you can use
advanced index value search methods to search for a wider range of documents.
You can use these search methods:

• Wildcards

• List of Values

• Expressions

To use the wildcard character:

1. In the New Search page, specify the index data by using the asterisk character
in at least one field. For example, specify SM* to search for documents with a
name that begins with the characters “SM.”

2. Click RUN to begin the search process. AppEnhancer Web Access searches the
active application for all records that match the specified criteria. If matching
documents are found, a list of those documents appears in the Query Results
page.

To use the search list:

1. In the New Search page, select the index field for which you want to specify a
list of values, and then click the Search list icon that is next to the field.

2. In the List Search dialog box, specify a value for the index field.

3. Click Add to add the value to the list.

4. Repeat steps 2 and 3 for each value that you want to include in the list.

To edit the values, you can replace a value from the list with a new value, delete
a value, or delete the list.

5. Click OK.

6. Click RUN to start the search.

To use expressions:

1. In the New Search page, select the index field for which you want to specify a
range, and then click the Search range icon that is next to the field.

2. In the Range Search dialog box, select the type of comparison you want to use.

Note: The DATE and TIMESTAMP fields support two additional
expressions. The Within and Older Than expressions enable you to
specify a number of days from the time of execution, rather than specify a
date. For example, a value of 60 for the Older Than type of comparison
indicates a search for documents that are older than 60 days.
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3. Specify a value for the selected index field.

Note: If you select Between, also type a value in the And text box.

4. Click OK.

Notes

• Ensure that you use the correct format to specify an expression syntax. If the
expression syntax is incorrect, an error message appears.

• An expression search does not return any null index values. To search for a
null index value, use {Null} or <Null> as the search criteria.

4.2.1.2 Using full-text queries

There are four types of full-text searches: All Words, Any Words, Exact Phrase, and
Expression. The thesaurus feature enables you to search for words that are related to
the search criteria. It contains a list of synonyms or keys for possible words to be
used in a search. You can also query for different versions of a document.

For information about the thesaurus feature, see the OpenText Documentum xPlore
Administration and Development Guide.

To use the full-text query criteria:

1. In the New Search page, select a Search Type for the full-text query.

2. Type the search criteria.

3. Select Thesaurus to search for synonyms.

AppEnhancer Web Access searches the thesaurus for synonyms or keys for
words in the search criteria.

Note: This option is available only when the xPlore full-text engine is used
to submit documents to the full-text database. For more information, see
the OpenText AppEnhancer Administration Guide.

4. If you want to run the query without saving it for future use, click RUN.

If the query retrieves only one document that includes the search criteria, the
document opens in Document Viewer. Otherwise, you can select a document
from the Query Results page, which lists the documents that include the search
criteria.

The Document Viewer opens to the page that includes the first instance of the
search criteria, or hit. Each hit in the page is highlighted. Also, a Full-Text
Search Results pop-up window indicates the number of hits on the current
page and the total number of hits in the document. The pop-up window also
enables you to move between the pages that include hits.
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Note: For unsupported files, the Document Viewer opens to the page that
includes the first instance of the search criteria and the Full-Text Search
Results pop-up window, however, the hits are not highlighted.

5. If you want to run the query at any time, click SAVE.

a. In the Save dialog box, specify a name for the query.

b. Select Available to all users to share the query with other users.

c. Click SAVE.

The query is saved under the relevant application and in the navigation panel.

Notes

• If the full-text search option is All Words, Any Words, or Exact Phrase, the
characters &@#$%^_~`:-+=\/\[]{}!,;() in the full-text search criteria are
replaced with a blank space. Quotation marks or single quotation marks
must appear in pairs in the search criteria.

• If the full-text search option is Expression, the characters &@#$%^_~`:-+=\/\
[]{}!,; in the full-text search criteria are replaced with a blank space.

4.2.1.2.1 Using expression search operators

Expression operators enable a focused document search. You can build a query by
combining words or text strings with expression operators such as and and or. You
can also combine operators for more complex searches.

Note: By default, AppEnhancer Web Access interprets search expressions from
left to right, one search operator at a time, and narrows the results with each
subsequent search.

The following table describes the expression operators with examples:

Operator Example AppEnhancer finds
documents with

ftand 'AEX' ftand 'Simon' Both AEX and Simon

ftor 'AEX' ftor 'Simon' Either AEX or Simon

ftnot 'AEX' ftand ftnot 'Simon' AEX but not Simon

? 'A?X' with wildcards A string of three consecutive
characters, in which the first
must be A, the second can be
any character, and the last
must be X

* 'S*' with wildcards Any string that begins with S
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Operator Example AppEnhancer finds
documents with

() 'AEX' ftand ('Simon' ftor 
'Schiff')

Either Simon or Schiff first,
and of those documents,
AppEnhancer retrieves the
ones that also have AEX

4.2.1.3 Using document retention query options

If an application has the retention feature enabled, you can choose query options to
search for documents based on their retention and retention hold status.

In the New Search page, specify document retention status from the Show list box.

For more information about retention query options and limitations, see “Working
with Document Retention“ on page 99.

4.3 Searching document properties
AppEnhancer Web Access enables you to search for documents based on document
properties. These properties include title, author, subject, owner, comment, and
keywords. Select the Enable Document Properties Search option in the User
Settings page to use this feature. The document property index fields appear below
the application index fields. Each property index field name is enclosed within
square brackets.

You can create a query by specifying the values for the document property index
fields available in the New Search page. For more information, see “Creating
queries” on page 46.

4.4 Multiple application searches
You can use the Multiple Application Search functionality to create and run queries.
These queries search multiple AppEnhancer applications for the selected index
information, full-text information, or both. For example, by using a multiple
application search, you can search three different applications for information about
the Social Security number 111-22-3333. Or, you could search for all documents
containing the text “most recent software releases.”

Multiple application searches must be configured to search applications that are
within the same data source.

Note: You cannot query for reports that are generated by AppEnhancer
Reports Management across multiple applications.
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4.4.1 Configuring multi-application searches
1. From the list of applications, select the application that you want to create a

multiple application search for.

2. Click the Search icon in the toolbar and select New Multi-Application Search.

3. In the Configure Multiple Applications Search dialog box, select the
applications that you want to include in the query and click the Add icon,
which is in between the two text boxes, to add the selected applications (along
with the associated index fields) to the Query Applications list.

4. Configure the index fields for the multi-application query. The fields that are
not used in a search criteria are identified by an X next to the field. You have the
following choices for each field:

• Click a field once to make it displayable. A check mark appears next to the
selected field to indicate that it appears in the search results, but is not used
as a search criterion.

Note: If an index field that is made displayable is not common to the
other selected applications, the field appears in the query results, but
does not show any information for documents that are retrieved from
those applications.

• Click a field twice to make it searchable. A search symbol appears next to the
selected field to indicate that it is used as a search field for querying
documents.

Note: Each application participating in a cross-application query must
have at least one searchable field.

5. Type a name for the multiple application search.

6. Select Available to all users to share the query with other users (public query).

If you do not select this option, other users are restricted from using this query
and the query is considered private.

7. Click SAVE.

The Edit Search page displays the index fields that were configured as
searchable.

8. Specify the search criteria and save the query.

You can use wildcards, expressions, full-text, and combination queries to define the
search criteria. For more information, see “Creating queries” on page 46.
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4.4.2 Using multi-application searches
The maximum number of results that are displayed in the Query Results page
cannot exceed the number that the administrator configures in the AppEnhancer
Web Access web.config file.

AppEnhancer/AppEnhancer Web Access security affects cross-application queries at
the application and document security level. For example, if the application security
setting restricts you from viewing an application that is part of a multi-application
query, the documents from the application do not appear in the query results.
Similarly, if document level security restricts you from viewing certain documents,
such documents are not retrieved when you run a multi-application query.

4.5 Working with saved searches
You can use saved queries multiple times. When you save a query, you can make it
available to all users. Otherwise, it is a private query that only you and the users
with the Administrator privilege can access. The saved queries are available under
the application for which they are created. A locked-padlock icon next to the query
name indicates that the query is private. An unlocked-padlock icon indicates that all
users can access and run the query. The query owner and the users with the
Administrator privilege can edit a query to change:

• A private query to public, after which the query becomes available in the list of
queries for all users and is preceded by the unlocked padlock icon

• A public query to private, after which the query becomes unavailable in the list
of queries for all users and is preceded by the locked padlock icon

Note: Even if a multi-application query is listed as public, you can see the
query only if you have access to at least one of the applications used in the
query. Also, if you do not have access to all applications within a multi-
application query, the query results do not show matches from the applications
that are restricted.

From the list of queries for an application, select a query and open the context menu
to view the list of operations you can perform on a query:

Option Operation

Run

To run a query

Edit

To edit the search criteria

Delete

To delete a query
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Option Operation

Configure

To configure a multiple application search

Note: A saved query is also available under the application in the navigation
bar. You can click the saved query to run the query from the navigation bar.

4.6 Working with query results
The index fields that are used in the search criteria appear as column headers in the
query results. You can customize the query results view by rearranging columns,
removing columns, or both, according to your requirements.

When you select a document from the query results, a toolbar appears. Assuming
you have the necessary privileges, you can use the toolbar menu to delete
documents, export COLD documents, email and print documents; and submit for
full-text indexing, OCR indexing, and to a business workflow. To perform these
operations on a single document, select a document and then click the adjacent
down-arrow icon to access context menu.

4.6.1 Exporting selected documents
You can export selected document(s) from query results.

1. From the Query Results Page, select the documents you want to export and then
click Export > Export Selected Document(s) on the toolbar.

2. In the Export Document dialog, select which item you want to export:

• Document Content(s): includes two sub-options: Use PDF Format and Hide
Annotations.

• Document Index(es)

3. Click EXPORT to start export.

After the export, the browser window displays the name of the downloaded
document(s). The Export Document dialog box displays the log. The file is
automatically downloaded to the downloads folder. You can save the file in another
location, if required. If the documents being exported are large and the progress is
slow, you can click Run job in backend in the export dialog. You can continue
working in Web Access and do not need to wait for the export job to complete.
When the export job is finished, a notification is displayed on the floating icon.
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EAXCORE230400-UGW-EN-1 User Guide 53



4.6.2 Document display from query results
After you run a query, you can select documents from the query results to view
them in the Document Viewer. Icons to the left of the document names indicate
either the document version (previous, latest, or final) for each document or whether
the document has been checked out. Page icons are also used to represent
documents that are available for retention filing. Depending on the requirement, you
can file the document for retention. For more information, see “Filing documents for
retention” on page 100.

Icon Description

Latest version of the document.

Previous revision of the document.

Checked-out document.

Latest version of the document under
retention.

Previous version of the document under
retention.

Latest version of the document on retention
hold. Documents under retention can be on
retention hold and this status overwrites the
retention period. The documents are not
deleted from the system but only have read-
only access.

Previous version of the document on
retention hold.

To display a document from the query results, select a document and then click
OPEN on the context menu. The selected document opens in Document Viewer. You
can then use the menu options and toolbar buttons to perform different tasks.

If you have selected Display Document in a Separate Popup Window under
Search/Result Set in the User Settings page, you can open and view multiple
documents simultaneously. Each document appears in a separate window.
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4.6.3 Printing selected documents
1. From the Query Results page, select the documents that you want to print and

click Print on the toolbar.

2. In the Print dialog box, select the pages that you want to print:

• All pages

• A range of pages

3. Select Hide Annotations to avoid printing the document annotations.

4. Click PRINT.

The selected pages are rendered as a PDF file and appear in a new browser
window or tab. If one of the selected documents is not rendered successfully,
the entire print job fails.

Note: Your browser must have a PDF reader plug-in, such as Adobe PDF
Reader, installed. Otherwise, the browser downloads the rendered PDF
file rather than display it in a browser window or tab.

5. Click the Print icon on the browser toolbar to select a printer and print the PDF
file.

Note: If the document being printed is large, it may take some time to
complete. In this case, you can click Run job in backend in the print dialog.
The print dialog will disappear and a floating icon will appear on the right-
bottom of the screen instead. You can continue working in Web Access and do
not need to wait for the print job to complet. When the print job is finished, a
notification is displayed on the floating icon. You can click the floating icon to
open the job manager dialog from which you can see the printed PDF result.
The Run job in backend function can also be used for email and export
functions.

4.6.4 Exporting selected COLD documents
PDF files (excluding secure PDF files), Plain Text, and Compressed Text are
considered Computer Output to Laser Disk (COLD) documents. You can export any
one of these types.

From the Query Results page, select the documents you want to export and click
Export > Export COLD from the toolbar.

To export a single document, select Export COLD on the context menu.

Note: When AppEnhancer Web Access processes the export request, it picks
up the file type that it encounters first and skips the rest. For example, assume
that you have selected two PDF documents and one text file for export. During
processing, if AppEnhancer Web Access encounters the PDF documents first, it
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merges the two PDF documents and exports them as a single PDF document. It
skips the text file.

After the export, the browser window displays the name of the downloaded
document. The Export Document dialog box displays the log. The file is
automatically downloaded to the downloads folder. You can save the file in another
location, if required.

4.6.5 Emailing selected documents
You can email documents, pages, and links with AppEnhancer Web Access
documents and pages. To enable these options, first register your email address. For
details, see “Registering email addresses” on page 71.

1. From the Query Results page, select the documents that you want to email.

2. Click Email on the toolbar.

Notes

• If the email server is not configured correctly, the Email Status dialog
box displays an error message.

• If the Mail Registration dialog box appears, configure your email
address before you send an email.

3. In the Mail Document dialog box, select the following:

Field Description

To The address of the email recipient. You
can select email addresses from the Select
Contact dialog box or type the email
addresses of multiple recipients.

Cc and Bcc Optional recipients, if required.

Subject The subject of the email.

Message Format The format in which the email must be
sent:

• HTML
• Text

Attach The type of attachment:

• Entire Document
• Page Range

If you select a range of pages, type the
starting and ending page numbers as
<#>-<#> in the text box.
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Field Description

Send Attachments as Hyperlinks Enables you to include attachments as
hyperlinks that appear in the message
body.

Notes
• Reports from AppEnhancer

Reports Management must be
emailed only as hyperlinks.

• The recipients of emailed
hyperlinks must have the
appropriate permissions within
the AppEnhancer system and
AppEnhancer Web Access to view
the documents.

Merge Selected Documents Into One Generates a new file that contains all the
pages of the selected documents.

Archive Documents Into One Zip File Includes the selected documents in a Zip
file format.

Hide Annotations Hides the annotations and redactions in
the selected documents before emailing
them.

Email Document Title The title of the selected documents
appears in the email body.

4. Type the message in the text box.

5. Click EMAIL.

A confirmation message appears that indicates that the email was sent
successfully.

Note: If your browser times out, the email is sent from the server.

4.6.6 Exporting document indexes
You can export document indexes to a web browser for online viewing, or to a file
that can be imported into a spreadsheet application, such as Microsoft Excel.

1. From the list of queries for an application, select a query and run it.

2. From the Query Results page, select one or more documents, and then click
Export on the toolbar.

3. Select a method for exporting the indexes:

• To export all the index values from the query results, click Export All
Indexes from the list.
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• To export only a chosen set of indexes, select the required documents from
the query results, and then click Export > Export Selected Document(s) >
Document Index(es) from the list.

AppEnhancer Web Access saves the indexes as a Tab Separated Value (TSV) file
or a Comma Separated Value (CSV) file.

4.6.7 Submitting selected documents to workflow
You can submit documents to a business workflow if the AppEnhancer Workflow
Integration Module is configured in AppEnhancer Administrator.

Note: You must be granted permission to submit documents to a workflow.

1. From the Query Results page, select the documents that you want to submit.

2. Click Workflow.

3. Select a business process from the list.

Note: The business processes are created in the AppEnhancer Workflow
Manager and AppEnhancer Workflow Integration Module is used to
connect to the workflow. Log in to AppEnhancer Workflow Manager to
check if the submission was successful.

4.6.8 Submitting selected documents for full-text indexing
1. From the Query Results page, select one or more documents, and then click

Submit on the toolbar.

2. Click Full-Text Index Job from the list, and then select the appropriate OCR
Language.

3. Click SUBMIT.

A confirmation message appears that indicates a successful submission.

4.6.9 Submitting selected documents to process OCR
1. From the Query Results page, select one or more documents, and then click

SUBMIT on the toolbar.

2. Click OCR Job from the list, and then select the appropriate OCR Language.

3. Click SUBMIT.

A confirmation message appears that indicates a successful submission.
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4.6.10 Deleting selected documents
1. Select the documents that you want to delete from the Query Results page.

2. Click Delete on the toolbar.

3. In the confirmation message dialog box, click DELETE to confirm the operation.

4.6.11 Performing Ad Hoc Text Search on Selected Documents
After submitting a query and receiving a list of documents matching the search
criteria, you can further refine the results or locate the text content by performing an
ad hoc text search on the records in the result set.

1. Locate the text search section on the query result toolbar, then type the
keywords in the text search input.

2. Click the Text Search icon to launch text search on selected documents in the
query result. The Text Search dialog appears.

• If there is no selected document, all documents in the current query result
page are searched.

• Alternatively, you can also perform a text search on a single document from
the query result context menu Ad Hoc Text Search.

3. During a search, the progress is displayed at the bottom of the Text Search
dialog.

• Click the Cancel button to stop text searching while it is processing.

• You can also search for other keywords from dedicated documents by
entering keywords in the search input and clicking the Text Search button in
the search dialog

4. Text search results are listed in the text search dialog. The text search results are
organized as follows:

• The first four hit pages for each hit document are listed by default. Click the
More hit pages link to view more hit pages.

• Hit words are highlighted for each page. To show more hit words, click the
More hits link.

• If specified keywords are not found in any document, the message The
specified text was not found is displayed.

5. To view any document in the list of text search hits, click the Page# link or the
hit word highlighted for the document you want to view.
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EAXCORE230400-UGW-EN-1 User Guide 59



4.6.11.1 The difference between xPlore and non-xPlore Applications

If an Application is using xPlore full-text engine, the text search is based on xPlore.
Web Access submits the text search criteria to xPlore, gets the hit information and
then shows the UI. Besides text document and the documents have OCRed text file,
PDF, Office documents and other documents supported by xPlore can be searched
via text search. The text search result on query result always displays text result with
hit information for both texture file and other files. But when opening the document
from the text results or doing a text search on an opened document, it shows
highlighted information based on the document types like full-text search
highlighting.

If no full-text engine is configured for an Application, Web Access does a text search
on the text content of the document. The text content could be:

• The original page content is a text file or compressed text file

• The page has OCRed text content

Web Access uses a simple search algorithm to perform text searches. It tries to find
keywords by exact match but does not perform word searching.

4.6.11.2 Wilcard support

Wildcard Character Finds xPlore Application non-xPlore
Application

* Any characters Supported Supported

? Any single character Supported Supported

@ Any single numeric
character

Not supported, will
be replaced by space.

Supported

# Any single numeric
character

Not supported, will
be replaced by space.

Supported

! Any single non-space
character

Not supported, will
be replaced by space.

Supported

4.6.12 Customizing the Query Results view
1. In the Query Results page toolbar, click the Customize Query Results icon on

the toolbar.

2. Select a row and click the Move Up icon or the Move Down icon, depending on
how you want to reorganize the index columns.

3. Select the index fields that you want to appear in the query results.

4. Click SAVE.
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Chapter 5

Viewing Documents

Effective data storage and retrieval is vital to a useful document imaging system.
When a document is retrieved from storage, however, the focus shifts from your
ability to access data to your ability to manipulate data. Displaying a retrieved
document in a way that highlights important data ensures efficient data processing.

AppEnhancer Web Access provides different viewing modes. In addition to viewing
a document, you can also view specific details such as the revision history,
document versions, image details, and document properties.

5.1 Using Thumbnails
Thumbnails are links to individual pages in a document that enable you to locate
and display a page from a large document quickly. When you view a document in
the Document Viewer, the page thumbnails appear to the left of the document
image.

1. If the thumbnails view is not enabled, select the Show Page Thumbnails option
under Document View in the User Settings page.

2. In an open document, click the Show/Hide Thumbnail icon on the left of the
toolbar to hide or view page thumbnails.

3. In the thumbnail view, click the down-arrow at the upper right to show the
thumbnail view toolbar, which is hidden by default.

4. Select a single page thumbnail, or press:

• Ctrl and then select multiple page thumbnails.

• Shift and select a beginning page thumbnail and an ending page thumbnail
to select a range.

• Ctrl +Shift and then select page thumbnails and retain any previously
selected page thumbnails.

The selected page thumbnails include a check mark on the upper left.
You can then perform these tasks:

• Drag and drop selected page thumbnails to reorder pages.

• Cut and paste selected page thumbnails to move pages.

• Delete selected page thumbnails to delete pages.

• Email, export, or print only the selected page thumbnails.

• Change the page thumbnail size by using the slider on the thumbnail view
toolbar.
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Note: You cannot cut, paste, or delete page thumbnails in read-only
documents or in documents for which you do not have permission.
You cannot cut, paste, or drag and drop page thumbnails in a batch
thumbnail view.

5. Optionally, drag an electronic file (or files) from your desktop into the
thumbnails view and hover over the page thumbnail before which you want to
place the file. Then, drop the file to insert it into the document.

5.2 Operation modes
AppEnhancer Web Access has four modes of operation: normal mode, check-in/
check-out mode, read-only mode, and reason audit mode. The normal and check-in/
check-out modes of operation enable the use of revision control in AppEnhancer.
Revision control keeps track of which user is working on a document and can also
be used to track previous revisions of a document. Reason audit mode is used to
audit document-related operations, such as document export and printing, and
record the reason that they are performed.

5.2.1 Normal mode
If your system is configured with the normal display mode, you can open
documents only in this mode. When AppEnhancer Web Access is in the normal
mode, use of revision control is optional. You can open and modify documents, and,
when you close them, the changes are automatically saved to the AppEnhancer
document repository.

You can check out documents in the normal mode to prevent other users from
making changes while you are working on a document. However, users are not
required to check out a document before making modifications.

Note: The reverse is also true. If another user checks out a document, you
cannot modify the same document until the user checks it in. To prevent
accidental data loss, it is strongly recommended that you check out documents
before you modify them.

5.2.2 Check-in/check-out mode
AppEnhancer Web Access check-in/check-out mode provides a more secure level of
version control than is provided in normal mode. It is strongly recommended that
you check out any document that you intend to edit. If you change a document
without checking it out, accidental data loss can occur if another user makes changes
to the same document simultaneously.

For example, assume that you are editing a document and have added a few pages
of new data. You have not checked out the document. Another user opens the same
document, without seeing the changes that you have made (because you are
currently working on them), and makes additional changes. Meanwhile, you close
and save the document. When the other user closes and saves the same document,
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their changes are saved, overwriting your work. All of your changes are lost. If you
had checked out the document before making changes, the other user would have
been able to open the document only in read-only mode and could not have made
any changes until you checked in the document.

If the AppEnhancer system administrator has enabled the check-in/check-out mode
on the AppEnhancer Web Access server, or if you have selected the Prompt for
Checkout option under Document View in the User Settings page, you are
prompted to specify whether you want to check out the document or open it as
read-only. The prompt does not appear if you open the following types of
documents:

• A previous revision of the document

• The final revision of a document

• A checked-out document; the document opens as read-only if checked out by
another user and continues in checked-out mode (resume check-out mode) if
checked out by the current user

Note: A resumed checkout might fail for a user who works on multiple
workstations. If a user opens the document that is checked out on
workstation A and then tries to do the same on workstation B, the resumed
checkout fails on workstation B, and the document opens as read-only.

If you do not select Prompt for Checkout, you can open the document and then
check it out by selecting Check Out from the Document menu.

When you check out a document, a copy of the document as it exists in the
AppEnhancer repository is created and this copy becomes your working copy. Even
when you close a document, you can keep the document checked out to continue
working on it.

If you have selected the Prompt for Checkout option for the application that you are
using, you can check in the final revision of a document. After you check in the final
revision, users can open the document only in the read-only mode.

Note: Users with the deletion privilege can delete the final revision of a
document from the AppEnhancer repository.

You can also cancel the checkout by selecting Cancel Checkout from the Document
menu. When you cancel the checkout, the working copy is deleted and
AppEnhancer considers the document revision in the repository as the current
revision. The changes that you made to the working copy are discarded.

When you finish your changes, you can choose to check the document back into the
repository. You can check in a document by selecting Check In from the Document
menu. When you check in a document, identify the status of the document revision.
You can assign the revision as minor, major, or a replacement for the current
revision.

5.2. Operation modes
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The following table lists the three document revision types and describes their
functions:

Option Description

Check in as a minor revision Creates a new document version, keeps the
previous version, and checks in the
document. The new version uses the same
document index information as the previous
version. For each minor revision, the version
number for the document increases by .1 (for
example, version 1.0 becomes version 1.1).

Check in as a major revision Creates a new document version, keeps the
previous version, and checks in the
document. The new version uses the same
document index information as the previous
version. For each major revision, the version
number for the document increases by 1.0
(for example, version 1.0 becomes version
2.0).

Replace the current revision Replaces the revision that was retrieved
when the document was checked out and
checks in the new document.

Final Revision Marks the document as final. The final
version of a document can be opened only in
the read-only mode; you cannot check out or
modify it.

Note: You can mark a document as
final only if the Prompt for Checkout
option is selected for the application.

5.2.3 Read-only mode
In the read-only mode, you cannot modify documents; you can only read them.
There are many circumstances when you might work with documents in the read-
only mode:

• If you have already checked out a document and then open another instance of
the same document

• If you select Read Only in the Document Version Control dialog box (appears
only if the Prompt for Checkout option is selected for the application)

• If you open:

– A document that someone else has checked out

– The final version of a document

– A document that is under retention

You cannot add or delete new pages or page revisions, add annotations or
redactions, or modify the document index for a read-only document. If you open a
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document as read-only and then decide to make changes to the document, assuming
that another user has not checked out the document, you can check out the
document by selecting Check Out from the Document menu.

5.2.4 Reason Audit mode
The AppEnhancer system administrator configures the Reason Audit mode at the
application level to facilitate compliance with the Health Insurance Portability and
Accountability Act of 1996 (HIPAA). If configured, when you select to view, print,
export, or email one or more documents, AppEnhancer Web Access displays the
Reason Code Required dialog box. In this dialog box, select a task that you want to
perform and describe the reason for performing the task.

5.3 Document Viewer toolbar and menu options
The Document Viewer toolbar includes buttons that enable you to manipulate
document images, print document pages, and display information about images,
among other things. If you have the proper permissions, you can use other buttons
to make annotations and redactions including lines, arrows, highlights, and text
annotations. You can use the buttons to show or hide annotations, save or delete
annotations, and position annotations with reference to a document or batch page.

The Document and Page menus also provide options to perform a wide range of
operations on an open document. The EMAIL, PRINT, and EXPORT options enable
you to perform these operations directly from the browser. For more information,
see “Printing selected documents” on page 55, “Emailing selected documents”
on page 56 and “Exporting selected COLD documents” on page 55.

Note: If Enable Inline Rendering of Foreign Files underDocument View is
selected in the User Settings page and Render foreign files as HTML is
enabled on the server, foreign files are rendered as HTML rather than links that
can be used to download or open the foreign file. If the foreign file is an
unrecognized file type, it appears as a link that you can use to download the
file.

5.3.1 Viewing subpages
If there is more than one subpage in a page (for example, in an Information and
Content Exchange (ICE), TIFF, DCX, or PDF page format), you can use the Next
Subpage and Previous Subpage buttons to navigate through the subpages.

5.3. Document Viewer toolbar and menu options
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5.3.2 Viewing page versions
If more than one version of a page exists, AppEnhancer displays the latest version
by default. You can use the Previous Page Version and Next Page Version buttons
to navigate through all the versions of a page. You can also add a new page version,
delete the current version, and delete all previous versions by using the appropriate
buttons on the Page Version toolbar.

5.3.3 Displaying image information
You can view the image information for a displayed document by selecting Display
Image Information from the Page menu on the toolbar.

5.3.4 Rotating multiple pages
You can rotate and save all or multiple pages of a document by selecting Rotate and
Save Multiple from the Page menu on the toolbar.

You have the option to select all pages or just the current page or provide a range of
pages.

5.3.5 Adding annotations
When you work with documents, several types of annotations are available. You can
add text annotations that can be viewed as actual text or as an icon. All annotations,
including text, can be placed within documents in the transparent or opaque (filled)
mode.

Note: When you add annotations to a document with subpages, you can add
annotations only to the first subpage of the document.

For more information, see “Annotations“ on page 87.

5.3.6 Viewing document properties
The Document Properties page enables you to view information about an active
document. To view this information, select Document Properties from the
Document menu on the toolbar.

You can view basic information such as the name of the application, revision
number, name of the person who created and the date of creation, and the login ID
of the person who has checked out the document, including the date and time of
checkout. These are system properties assigned by AppEnhancer Web Access. You
cannot change them.

You can specify the following additional information:

• Title of the document

• Subject of the document

Chapter 5   Viewing Documents

66 OpenText™ AppEnhancer Web Access EAXCORE230400-UGW-EN-1



• Author of the document

• Relevant keywords related to the content of the document

• Comments about the document

After specifying the details, you can save the properties or reset the properties to
their original values. You can retrieve documents by using these document
properties in a search criteria.

5.3.7 Deleting a document
When you delete a document, it is immediately deleted by default. At the
Application level, an administrator can enable the Recycle Bin feature to temporarily
store deleted documents for review before permanently deleting a document. Once
the Recycle Bin feature is enabled, all deleted documents are moved to the Recycle
Bin.

To delete a document, select Delete Document from the Document menu on the
toolbar.

5.3.8 Viewing revision history
When you create multiple versions of a document, AppEnhancer creates a record of
the revision history. It lists the revisions that have been made, the user who has
checked in each revision, the date the revision was made, and the check-in comment.
You can also open or delete a specific revision.

To view the revision history, select Revision History from the Document menu on
the toolbar.

5.3.9 Deleting a document revision
When you delete a revision of a document, the item is deleted by default. At the
Application level, an administrator can enable the Recycle Bin feature to temporarily
store deleted revisions for review before permanently deleting a revision. Once the
Recycle Bin feature is enabled, all deleted revisions are moved to the Recycle Bin.

To delete a revision, in the Document Revision History dialog, locate the revision
version you want to delete and click Delete Revision, .

Note: When the latest document revision is deleted, the previous version
becomes the active version.

5.3. Document Viewer toolbar and menu options
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5.3.10 Using text view
During the OCR process, a scanned image of a document or a page is converted into
actual text. Text view shows the OCR result of the image. To view the actual text,
select Text View from the Page menu on the toolbar.

5.3.11 Performing a text search
1. Click Text Search to perform a text search in the opened document. The Text

Search dialog appears.

2. Enter keywords in the search input filed and click Text Search to begin
searching.

3. If the keywords are found, the viewer navigates to the first hit page and
highlights the hit words.

If the keyword are not found, the viewer displays The specified text was not
found.

4. Click Previous Hit Page or Next Hit Page in the Text Search dialog to navigate
to other hit pages.

5.3.12 Restoring a recycled document or revision
When a deleted document or revision is in the Recycle Bin, you can restore the
document or revision to its original location.

To restore a document or document revision:

1. Run a query that includes Recycled documents and optionally, select Include
previous document revisions if you want to include revisions.

2. On the Query Results screen, locate the document or revision you want to
restore and select its respective check box.

3. Click Restore, .

5.3.13 Permanently deleting a recycled document or revision
When the Recycle Bin is enabled, deleted documents and revisions are sent to the
Recycle Bin to store and review a document or revision before deletion.

To permanently delete a document or document revision:

1. Run a query that includes Recycled documents and optionally, select Include
previous document revisions if you want to include revisions.

2. On the Query Results screen, locate the document or revision you want to
delete and select its respective check box.

3. Click Permanently Delete, .
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4. In the AppEnhancer Web Access dialog, confirm the deletion by clicking
PERMANENTLY DELETE.

5.4 Viewing foreign files
The AppEnhancer Web Access administrator determines the method that
AppEnhancer Web Access uses to processes foreign files.

The HTML versions of foreign files are displayed if the administrator has configured
the system for this feature and you have selected Enable Inline Rendering of
Foreign Files for Document View in the User Settings page.

If you do not select Enable Inline Rendering of Foreign Files, the name of the
foreign file appears as a link in the Document Viewer. You can download the file or
render it to open in another window. To open or save the foreign file, click the
download link. If the native application of the file is installed on your workstation,
you can view the file in that application. If the native application is not installed, you
can only save the file.

5.5 Viewing AppEnhancer Reports Management
reports
You can retrieve reports from the AppEnhancer Reports Management module by
creating a report specific query.

To create a new report query:

1. From the list of applications, select the application for which you want to create
a query.

2. Click the Search icon on the toolbar and select New Report Search from the list.

3. Specify the search criteria to locate the reports you want to retrieve.

Note: There are only three fields: TIMESTAMP, DESC (Description), and
RPTTYPE (Report Type). You can use all the index field query methods on
these fields. For more information, see “Single-application searches”
on page 46.

4. Click RUN to run the query.

Note: If you do not have an AppEnhancer Reports Management license,
an error message appears after you click RUN.

5. In the Query Results page, select the report that you want to view and then
click Open on the context menu.

The report appears in the Document Viewer.

You can navigate through the pages of the report and then email them.

5.4. Viewing foreign files

EAXCORE230400-UGW-EN-1 User Guide 69



5.6 Viewing and editing Microsoft Office files
You can use AppEnhancer Web Access to view and edit Microsoft Word, Microsoft
PowerPoint, and Microsoft Excel documents.

1. In AppEnhancer Web Access user profile settings, select the Open Office
Documents with Office Online Server check box.

2. Open a Microsoft Office document from the query result set or upload a new
document. The document content is presented within the embedded Office
Online Server (OOS) viewer.

3. To edit the document, click Edit in Browser.

4. To stop editing, click View > Document Views > Reading View. The modified
document is uploaded to a temporary storage location.

5. When you are finished, click the Save to AE icon. The document is saved as a
new page version.

Note: You can edit only one Microsoft Office document at a time in OOS.
When editing a document, you cannot open another AppEnhancer
document, page, or page version. If you choose to navigate to another
document, you will receive a prompt to stay and save or leave the
document without saving.

OOS only supports editing of OpenXML format (.docx, .xlsx, .pptx), not
binary format (.doc, .xls, .ppt).
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Chapter 6

Managing Documents

A full range of document management functionality is available in AppEnhancer
Web Access, including the ability to print, email, delete, and export documents and
pages. You can also modify the index field values of documents.

6.1 Using the email functionality
You can email selected documents either as inserted files or links. You can access the
email functionality from the Query Results page or within Document Viewer.

Note: You can save email messages in MSG or EML format and open them in
an email client such as Outlook. You do not need to register your email address
in this mode. The AppEnhancer system administrator enables the Save Mail to
Client setting to enable you to use this mode.

Caution
If your WX server has Outlook x64 installed, the client email for MSG
format will not work due to compatibility issues. To resolve this, perform
one of the following actions.

• Uninstall Outlook 64bit and install Outlook 32bit.

or

• Uninstall Outlook 64bit and rerun the Web Access Installer. It will
install the CDO component.

6.1.1 Registering email addresses
Before you can email documents, register your email address in the system.

1. In the Mail Registration dialog box, type your email address in the SMTP
format (yourname@yourcompany.com).

2. Click OK.

3. After the system processes and adds your email address into the repository, it
sends a confirmation code to the registered email address.

4. Open your email client and check for a message with the AppEnhancer Web
Access Email Registration ID. Open the message and copy the confirmation
code from the message.

5. Return to the Mail Registration dialog box and paste the confirmation code in
the corresponding text box.

EAXCORE230400-UGW-EN-1 User Guide 71



Notes

• If you accidentally delete the email message before copying
confirmation code, click Resend confirmation code to the supplied
email address to have another confirmation code sent to the registered
email address.

• Always use the most recent confirmation code.

6. Click OK.

The Mail Document dialog box appears where you can specify the details for
emailing documents.

For more information, see “Emailing selected documents” on page 56.

6.1.2 Changing the registered email address
If your email address changes, update your registered email address with the new
address.

1. From the Query Results page, select the documents that you want to email.

2. Click Email on the toolbar.

3. In the Mail Document dialog box, click the Change link.

4. In the Mail Registration dialog box, replace the current email address with
your new email address.

5. Click OK.

6.1.3 Saving email
You can save unsent email messages as MSG or EML files. You can then open the
saved messages in an email client application and send it at a later time.

1. From the Query Results page, select the documents or pages that you want to
email.

2. Click Email on the toolbar.

3. Select All Pages or specify a page range.

4. Type a subject and the body of the message.

5. Select the email options.

6. Select either MSG Format or EML format.

7. Click EMAIL.
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6.2 Creating new page versions
AppEnhancer Web Access enables you to save up to 255 versions of a single
document page.

1. Locate the document to which you want to add pages, by querying the
corresponding AppEnhancer application.

2. From the Query Results page, select the document and then click Open on the
context menu.

The first page of the document appears in the Document Viewer.

3. Select a page by using the page thumbnails, click the Page menu on the toolbar
and then select New Version.

4. In the New Page Version dialog box, browse and select an electronic file.

5. Click UPLOAD.

AppEnhancer Web Access displays the new version of the page. If you have
uploaded more versions, you can view the total number of versions for the page
and also move from one version to another.

6.3 Moving or copying document pages
AppEnhancer Web Access enables you to move or copy document pages between
AppEnhancer applications. It processes the pages as a new batch in the target
application. You must have the Batch Scan privilege for the target application and
the Delete Page privilege for the source application to move pages. The Batch Scan
privilege for the target application is sufficient to copy pages.

1. Locate the document to which you want to add pages, by querying the
corresponding AppEnhancer application.

2. From the Query Results page, select the document, and then click Open on the
context menu.

3. Select the document page by using the page thumbnails, click the Document
menu on the toolbar, and then select Copy or Move Pages.

4. In the Copy or Move Pages to New Batch dialog box, specify the following:

6.2. Creating new page versions
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Field Description

Document Pages The page number of the page you want to
move or copy.

To specify a continuous page range, insert
a hyphen between the first and last page.
Example: 1-4.

To specify separate pages, insert a comma
between each page. Example: 2,4.

To specify different page ranges, insert a
comma between each range. Example: 1-2,
5-9.

Include Page Versions Move or copy all versions of the selected
pages.

Note: If you move or copy multiple
versions of a one-page document,
AppEnhancer Web Access converts
the page versions to separate pages
in the target application.

Target Application The application to which you want to
move or copy the pages.

Batch Name The name of the batch.

Batch Security Security settings for the batch (Public,
Private, or Group).

Index New Document Index the batch immediately after moving
or copying the pages. If you do not select
this option, select the batch from the
Uploaded Batches list when you are ready
to index the batch.

5. Click MOVE if you want to move the selected pages from the source
application.

6. Click COPY if you want to leave a copy of the pages in the source application.

6.4 Exporting documents
1. Open a document from the Query Results page.

2. Select Export Document from the Document menu.

3. In the Export Document dialog box, select the pages that you want to export: all
pages, current page, or a range of pages.

4. Select Hide Annotations to avoid exporting the annotations on the page.

5. Click EXPORT.

After the export, the browser window displays the name of the downloaded
document. The Export Document dialog box displays the log. The file is
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automatically downloaded to the downloads folder. You can save the file in another
location, if required.

6.5 Adding pages to AppEnhancer documents
1. Locate the document to which you want to add pages, by querying the

corresponding AppEnhancer application.

2. From the Query Results page, select the document, and then click Open on the
context menu.

3. To append new pages to the end of the document, drag and drop the electronic
file or files from your desktop into the open document area.

4. To insert the new pages before or after a particular page in the document:

a. Select the page thumbnail. The page appears in the Document Viewer.

b. From the Page menu, select New Page.

c. In the Add New Page dialog box, browse and select the electronic file that
you want to append to the document.

d. Select the position where you want to add the new pages.

e. Click UPLOAD.

The new pages are inserted in the document at the selected insertion point.
Thumbnails of the uploaded pages appear at the corresponding point in the
sequence of thumbnails.

When you add a mail file (.MSG format) to a document, you can choose to add the
mail attachment as new pages. When you do so, the new uploaded file will be split
into several pages, depending on how many attachments the file has. The user
setting Import Email Attachment as New Page enables or disables this function.

6.6 Scanning pages to documents
You can also add pages to batches by scanning (New Page, Replace Page and New
Version).

For New Page operation, you can scan and insert the scanned pages before or after
the current page, or append to the current document.

For Replace Page , you can scan and replace the current page with the scanned page
(only the first page scanned is used to replace the current page).

For New Version , you can scan and create a new page version for the current page
(only the first page scanned is used to replace the current page version).

6.5. Adding pages to AppEnhancer documents
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6.7 Field masking
AppEnhancer administrators can use a validation mask to specify the exact format
(character pattern) required for each text index field that is associated with an
application. If the administrator selects the Validation Mask option for a text field
(in AppEnhancer Administrator), AppEnhancer performs a character-by-character
validation of each value that you specify for an index field during the document
indexing process. This action ensures that data is stored in the database in the
designated format.

AppEnhancer extends the concept of field masking to enable administrators to mask
field display values. This feature prevents you from viewing confidential data in
index fields.

You can view the index fields when you view documents from the Query Results
page. The masked field values are not visible in the AppEnhancer Web Access user
interface, regardless of user permissions. An asterisk (*) appears in place of each
masked character in the index field. You can modify the index values for masked
fields, but you cannot view the original value.

6.8 Modifying index field values
If you have the appropriate permissions, you can access AppEnhancer documents
and modify their index field values. For information about indexing instructions, see
“Indexing batches manually” on page 39 and “Using the Auto Index feature”
on page 43.

1. From the list of applications, select an application and run a query.

2. From the Query Results page, select the document, and then click Open on the
context menu.

The first page of the document appears in the Document Viewer. If you have
selected Show Index View under Index in the User Settings page, the current
index values for the document also appear in the index fields. Otherwise, click
the arrow icon on the center right of the page to open the index view.

3. Click MODIFY.

4. Make the necessary changes to the index data.

Note: If you have selected Enable Dual Data Entry under Index in the
User Settings page, type the relevant field values twice to validate the
value.

5. Click SAVE.
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6.9 Batch deleting documents
If you have Delete Doc and Retention Administrator permissions on an
application, you can batch delete the documents in that application.

1. Select an application from the list.

2. Click the plus (+) symbol in the upper right corner, then Retention
Administration.

3. In the SELECT MODE tab, select Dispose of documents from the application
then click NEXT.

4. In the SEARCH DOCUMENTS tab, input the query criteria and click NEXT.

Note: The default maximum number of query results retrieved per query
is 1000. You can change the value of MaxQueryResults in the file web.
config to change the maximum number of query results retrieved per
query.

5. In the SELECT DOCUMENTS tab, select the radio button Process all
documents found or select the documents you want to delete and click RUN.

6. In the PROCESS RESULT tab, click FINISH or RESTART to end the process.

6.10 Archiving documents
If you have Administrator and Migrate Application permissions in Web Access, you
can create an archive job.

Note: To use this feature, you need to install Administrative Services and
configure this feature in AppEnhancer Administrator.

1. In Web Access, navigate to an application.

2. Click the  icon > Archive.

3. On the Job Configuration tab, set the destination, annotation, and OCR text
folders, and enter a job description. The default value of the job description is
automatically set to the format <UserName>-<DataSourceName>-<Application>,
but you can customize it with any other description.

When you are finished, click Next.

4. On the Archive Job Summary tab, confirm that the information is correct.

When you are finished, click Next.

5. On the Search Documents tab, input the query criteria for the documents.

When you are finished, click Next.

6. On the Select Documents tab, select the documents that you want to archive.

6.9. Batch deleting documents
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7. Click Run.

The Process Result page appears when the archive job is created successfully.

8. Click Finish.

Notes

• If the Archive Job contains OCR documents, you need to restart the
AppEnhancer Index Agent service and resubmit the OCR job after the
Archive Job is finished.

• If the Archive Job contains full text documents, you need to complete
full text indexing again after the Archive Job is finished.
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Chapter 7

Migrating documents

Creating a migration job enables you to migrate applications from one data source to
another or within the same database.

You can migrate all or some of the documents in an application. All index
information, annotations, and the document file itself are migrated automatically,
but the migration can be expanded to include security settings and AppEnhancer
Reports Management report view information. Custom data types and formats are
migrated, but only the ones being used by the source application, and only if they do
not already exist in the destination application. In some cases, you can limit the
migration to index information only, excluding the actual documents.

If the application does not exist on the destination database, a new application will
be created. If the application already exists on the destination database, you can
choose to merge the documents into the destination application, or to overwrite all
existing documents in the destination application with the source application.

Settings from a migration can be saved and reused, making the migration process
almost automatic for subsequent migrations.

Notes

• You could create a new Software Retention Management application, but it
is not considered a retention-enabled application until the Retention
Administrator configures retention for the application using the RM
Configuration Utility.

• User must have Administrator and Migration permissions to perform a
migration.

7.1 Document migration rules
The following rules pertain to migrating documents during migration:

• Index-only migrations are permitted only when the migration involves like
applications. Any existing retention configuration information (that is, retention
policies and/or classes defined for the source application as well as retention
periods for documents) is exported to the new application.

• The index field structure of the new application must be identical to the old
application.

• The following items are not migrated:

– If an application is migrated with batches waiting to be indexed, the non-
indexed batches are not migrated. Batches should be indexed before an
application is migrated.
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– Full-text and OCR information from the full-text database is not migrated.

– If you are copying documents from a source application that is retention
enabled, retention configuration options are discarded. Retention
Administrators can configure the destination application for retention by
using the RM Configuration Utility.

7.2 Migrating applications
There is a step-by-step UI for application migration between databases. You can
select the documents to be migrated by specifying search criteria that describe which
documents will be included in the migration. You can choose to:

• Migrate an application to a database that does not already contain the application

• Merge the application with an existing application in the destination database

• Write the application over an existing application in the destination database

• Append the application to an existing application in the destination database

• Migrate an application within the same database

• Migrate index information only

• Migrate security information

• Migrate previous revisions

• Migrate annotation groups

Document annotations in the application are migrated automatically.

The following table describes the migration options:

Option Description

Replace Destination Overwrites an existing application on the
destination database.

When this option is enabled, the Merge
option is disabled automatically and the
Allow duplicate indexes option is disabled.

Caution
Selecting this option will
permanently delete the existing
documents in the destination
application. Recovery of the data is
not possible through
AppEnhancer.
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Option Description

Delete Source Documents Deletes migrated documents from the source
application.

All index information and referenced image
or report files will also be deleted.

Caution
Selecting this option will
permanently delete the migrated
documents and the index
information referencing the
documents from the source
database. Recovery of the data is
not possible through
AppEnhancer.

Migrate Indexes Only Migrates index information only and exclude
the actual documents.

The actual object files referenced by the
index information are not migrated to the
destination database. This feature can be
useful, for instance, when converting to
Microsoft SQL Server from a runtime
database. The storage location for the actual
document files need not change.

Notes
• This option is available only when

the migration involves like
applications. In addition, the
destination application must have
the same name and index field
structure as the source application.

• If the source application is retention-
enabled, retention configuration
settings specified using the RM
Configuration Utility (that is,
retention policies and classes defined
for the application) are maintained
in the target application.

• When this option is enabled, the
Delete Source Documents option is
disabled automatically.

7.2. Migrating applications
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Option Description

Merge Merges the source application with the
destination application.

When this option is enabled, the Allow
Duplicate Indexes option is disabled
automatically. If the source application has
the Multiple indexes referencing a single
document option enabled, the Merge option
will not be available.

Allow Duplicate Indexes Enables duplicate indexes in the destination
application.

This option is enabled by default. This option
cannot be enabled if Merge is enabled,
because Merge overwrites destination
documents with that have matching index
terms.

Note: This option is not enabled if the
destination application is being created
or replaced. If Replace Destination is
enabled, the Allow Duplicate Indexes
option becomes enabled and cannot be
altered. If the destination application
does not exist, it does not matter if
Allow Duplicate Indexes is Enabled or
disabled.

Migrate Security Migrates security settings with the
application, including Document Level
Security.

Each user and group that has privileges in
the source application will be migrated.
Document Level Security is also migrated
during a security migration.

Note: Security is migrated only if
Replace Destination is enabled or if the
destination application does not
already exist.

Migrate Previous Revisions Migrates all revisions of all documents in the
application.

This option migrates previous revisions and
current revisions from the source database to
the target database. If this option is disabled,
only the current revision of each document is
migrated.
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Option Description

Migrate annotation groups Migrates all annotation groups in the source
data source (and the user and group
accounts associated with those annotation
groups).

The configuration for each user and group
within the annotation group is migrated, but
user settings and privileges are not migrated
with the user accounts (unless you have
chosen to migrate security as well).

After migration, you must use AppEnhancer
Administrator to assign privileges to each
user that was migrated as part of an
annotation group migration (unless the user
was migrated as part of a security
migration).

Use alternative security Maps users and groups in the source
database to users and groups in the
destination database.

When the migration is performed and if this
option is enabled, only the users and groups
with alternative security information
configured in AppEnhancer Administrator
are migrated.

Note: You must configure security
mapping in AppEnhancer
Administrator prior to running the
migration if you want to use this
option.

Caution
If you do not enable this option
during the migration, all users and
groups will be migrated, even if
you have configured specific users
or groups for security mapping.

7.2. Migrating applications
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7.2.1 Migrating security
Follow these rules when you perform a security migration:

• When an application is migrated with migrate security selected, copy source
security to the destination database for all users and groups that have access to
the migrated application.

• When group security is migrated, migrate all users that belong to the group to
the destination database.

• For both user and group profiles, copy the source global profile to the destination
application if it does not already exist. If a global profile already exists on the
destination database, it is not overwritten.

Note: For both user and group profiles, the application-specific profile located
in the source database always overrides the application-specific profile in the
destination database.

For user settings, permissions are verified for all individual users, and if the
destination permissions are not the same as the source (possibly due to membership
in multiple groups), the application-specific profile is created or altered to match the
user permissions in the source database. If the source data source is using a different
security provider than the destination data source, ensure that required actions are
taken and conditions are met, as described in the following table:

Question To database using CM
security provider

To database using
Windows

What is migrated? • All users and groups that
have privileges in the
source application

• All users and groups that
have privileges in the
source application

• All users who are
members of those groups

What needs to be done after
migration?

• Assign passwords to each
migrated user account

 

Which migrated user
accounts can be used after
migration?

• All migrated user
accounts

All migrated user accounts

• For the Windows security
provider, the user
accounts that have
domain name in the user
account name
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7.2.2 Migrating annotation groups
If the source data source is using a different security provider than the destination
data source, ensure that required actions are taken and conditions are met, as
described in the following table:

Question To database using CM
security provider

To database using
Windows

What is migrated? • All annotation groups in
the data source

• All users and groups that
have been added to those
annotation groups

• All annotation groups in
the data source

• All users and groups that
have been added to those
annotation groups

• All users who are
members of those groups

What needs to be done after
migration?

• Assign privileges to each
migrated user account

• Assign passwords to each
user account that has
been migrated as a result
of the annotation group
migration

• Assign privileges to each
migrated user account

Which migrated user
accounts can be used after
migration?

• All user accounts Only valid user accounts:

• For the Windows security
provider, the user
accounts that have
domain name in the user
account name

7.3 Creating a migration job
If you have Administrator and Migration permissions in Web Access, you can create
a migration job.

Note: To use this feature, you need to install Administrative Services and
configure this feature in AppEnhancer Administrator.

1. In Web Access, navigate to an application.

2. Click the  icon > Migration.

3. On the Migration Options tab, configure the migration settings manually or
click Load Settings to load existing settings from a migration settings file.

When you are finished, click Next.

4. On the Query Criteria tab, query and list the documents that you want to
migrate.

When you are finished, click Next.

7.3. Creating a migration job
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5. On the Report Query Criteria tab, query and list the reports that you want to
migrate.

When you are finished, click Next.

6. On the Migration Job Summary tab, confirm that the information is correct and
click Submit.

The Process Result page appears when the migration job is created successfully.

Note: If you wish to create multiple migration jobs for other applications
using the same settings, click Create Batch.

7. Click Finish.
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Chapter 8

Annotations

AppEnhancer Web Access enables authorized users to attach annotations to
AppEnhancer document or batch pages to highlight important information,
comment on the contents of the page, or block areas of the page from view. You can
add annotations to images, text, and PDF files.

Note: If your user account includes annotation group options but does not give
you individual annotation privileges, set the annotation group as the default to
be able to use the annotation features. The AppEnhancer system administrator
can specify this setting for your user account in AppEnhancer Administrator.

You can customize annotation properties to create the effects that you want. For
example, you can change the line width and colors of annotations. Or you can use
the filled setting with the redaction feature to make annotations opaque to block
sections of a document from view. A show/hide feature enables you to view or hide
annotations with a click. You can also save or delete annotations.

There is no limit to the number of annotations you can place on a page; however,
many annotations might slow or distort page rendering.

In addition to placing multiple annotations on an image, you can overlap
annotations, extending one annotation over another. A new annotation, if added to
overlap an existing one, is placed on the top or front “layer” of the page. The
existing annotation is placed on the bottom or back “layer” of the page.

Note: When overlapping annotations, create the annotations by using the
redaction feature so that the colors appear opaque. Otherwise, the colors
appear transparent and you might be unable to distinguish between the two
annotations.

8.1 Annotation types
There are five types of annotations that you can add to AppEnhancer documents:

• Line annotations: These include the straight line, the freehand line, the arrow, and
the polyline.

– You can use the freehand line feature to draw curved lines, straight lines, and
combination lines (lines with curved parts and straight parts).

– A polyline consists of a series of straight lines connecting multiple points or
nodes. Because the nodes defining the polyline do not have to be aligned, you
can create line annotations that are not straight lines. Polyline annotations can
contain angles and can even delineate shapes. You cannot fill color to a shape
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that you create with the polyline annotation. To create a custom shape by
using straight lines and a fill color, use the polygon shape annotation.

• Shape annotations: These include the rectangle, the rounded rectangle, the oval,
and the polygon.

A polygon consists of a series of connected straight lines that form a closed
shape. You can fill polygon annotations with color. This option also enables you
to create asymmetrical shape annotations with a number of user-defined sides.
The nodes that define the polygon do not have to be in alignment.

Shape annotations have a fill color and a line color.

• Highlight annotations: These are similar to rectangle annotations, except that they
have no fill color and you cannot configure the default color.

• Text annotations: These have both fill color and line color configuration options,
and can be displayed as either text or icons.

• Rubber stamp annotations: These include rubber stamp annotation attributes such
as type (text or image) and content (text string or embedded bitmap) as well as
the standard annotation attributes.

Note: Rubber stamps become available for use only after the AppEnhancer
system administrator creates and configures them.

Annotations can be transparent or nontransparent (opaque). Lines, shapes,
highlights, and rubber stamps are transparent by default. Text annotations are
nontransparent by default. You must have redaction privileges to create and modify
nontransparent annotations.

8.2 Creating line and shape annotations
Before you create the line and shape annotations, configure their properties by using
the format settings available on the toolbar.

8.2.1 Configuring annotation properties
The first step to create a line or shape annotation is to check the current annotation
properties, and, if necessary, change the defaults. For example, all annotations have
default color settings that you can change. You can select a different line color, fill
color, or both before adding an annotation to a document. You can also modify the
default line width, by making it broader or narrower.

Note: Default colors for text annotations are set separately. For more
information, see “Creating text annotations” on page 91.

You can Description

Set line width settings for line and shape
annotations

Click the Line Width icon on the Format
toolbar and select a width of your choice.
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You can Description

Set shape line and fill colors for line and
shape annotations

Note: Set the default colors before
creating the annotation.

Click the Line Color icon on the Format
toolbar to select the line color. Click the
arrow next to the Change Fill Color icon on
the Format toolbar to open the color palette
and select the fill color.

Change the color for highlight annotations
after you create them

The default color for highlight annotations is
yellow. You cannot change this setting. After
you create a highlight annotation, you can
change the highlight color from the
Annotation Properties dialog box.

Set the fill property This property enables you to fill an
annotation with a selected color, rather than
using only a line color to show the outline of
the annotation.

Note: You can change the default line
width settings from the Annotation
Properties dialog box. For more
information, see “Modifying
annotations” on page 96.

Set the redaction property This property enables you to hide parts of a
document by changing the view from
transparent to opaque.

Note: You can change the default line
width settings from the Annotation
Properties dialog box. For more
information, see “Modifying
annotations” on page 96.

8.2.2 Adding annotation types
After configuring annotation properties, you can add different types of annotations
to an AppEnhancer page. You can apply text, line, shape, or highlight annotations
that emphasize a specific area of the image. You can also apply rubber stamp
annotations created by the AppEnhancer Administrator.

You can add Description

Line annotations Click the Line icon on the Annotation
toolbar. To select a different line, click the
down-arrow icon next to the Line icon and
choose a line from the list box.

Note: When a polyline is complete,
double-click to complete the action.

8.2. Creating line and shape annotations
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You can add Description

Shape annotations Click the shape icon (for example, the Oval
icon) on the Annotation toolbar. To use a
different shape, click the down-arrow icon
next to the shape icon and select a shape
from the list box.

Note: When a polygon shape is
complete, double-click to complete the
action.

Highlight annotations to emphasize or bring
attention to a particular area of an
AppEnhancer document

Click the Highlighter icon on the
Annotation toolbar and drag the mouse
pointer from a starting point to an endpoint.
As you drag the pointer, a new annotation
appears on the page. New highlight
annotations appear in yellow by default.

Fill annotations You can set the default fill color for shape
annotations. When you create an annotation
shape without selecting the filled setting,
only the outline of the shape appears on the
page.

When you fill shape annotations with color,
the fill color is transparent; you can see the
page through the color. If you click both the
Fill Color and the Redaction icons on the
Format toolbar before creating the
annotation, the fill color appears opaque,
hiding the part of the page underneath the
shape.

Redactions The redaction feature causes colors to appear
opaque instead of transparent. If you click
the Redaction icon on the Format toolbar
before you create a line or shape annotation,
the line or shape outline appears opaque.
You can add redactions along with the fill
color option to block areas of images or text
pages.

After you add annotations, click the Save Changes icon on the Actions toolbar.
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8.2.2.1 Interaction between redactions and OCR/full-text

When applying redaction annotations, keep these points in mind:

• If you use an annotation with redaction to hide text on a document that was
previously OCR-processed and then save the annotated page, the existing text
view of the document is deleted.

• If you use an annotation with redaction to hide text on a document that was
previously full-text indexed and then save the annotated page, the existing text
view of the document is deleted and the document is automatically resubmitted
to Index Agent.

• If you use an annotation with redaction to hide text in a PDF file and then submit
the PDF file to Index Agent for full-text indexing, the text that is hidden behind
the redaction is not removed. Users who do not have the appropriate privileges
to use redaction to hide text can find the document by performing a full-text
search with the hidden text as the search criteria.

Note: Redaction on PDF files is not supported.

8.3 Creating text annotations
When you attach text annotations to documents, the text appears on the document
page inside a box. Both the text and the box are nontransparent by default.

Notes

• You must have redaction privileges to create and modify nontransparent text
annotations.

• You must have the Global Annotations privilege to view or modify a text
annotation that another user creates.

To create a text annotation

1. Open the document that you want to annotate and click the Text icon on the
Annotation toolbar.

2. Click the location on the image where you want to place the comment.

3. In the Add Text Annotation dialog box, specify the following:

Field Description

Annotation Text The text that you want to use as the
comment.

Font The font size, color, and other properties
you want to apply to the text.

Display as Icon Displays the textual comment as an icon.
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Field Description

Set as Default Saves the current specifications as the
default setting.

4. Click OK.

8.4 Rubber stamp annotations
Rubber stamp annotations are predefined annotations that you can use to describe
certain events. For example, you can have a rubber stamp that says “Added by
<Username> on <Date>” where Username and Date are populated by your name and
the date on which you have added the annotation. Some rubber stamps can be
composed of an image so that you can place a signature, or other relevant graphic
images, on a document page.

Note: The AppEnhancer system administrator must create and configure
rubber stamps before they are available for use. Only users with appropriate
privileges can control rubber stamp annotation features.

8.4.1 Adding rubber stamp annotations
You can select rubber stamps from a list of available stamps. This list includes all the
rubber stamps created for the current application.

To add a rubber stamp annotation:

1. Open the document that you want to annotate and click the Rubber Stamp icon
on the Annotation toolbar.

2. From the Select a Rubber Stamp from the list dialog box, click the rubber
stamp that you want to use.

3. Click OK.

4. Point the cursor to the location in the open document where you want the
rubber stamp to appear and click.

5. Click the Rubber Stamp icon on the Annotation toolbar to cancel the rubber
stamp function.
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8.4.2 Preparing a rubber stamp file for Web Access
If you have a text-based rubber stamp file from the Document Manager desktop
application and want to use it in Web Access, you must manually modify the .txt
file before it can be used.

To modify a rubber stamp file for Web Access:

1. Open the rubber stamp .txt file in your preferred text editor.

2. Delete the XML tag information in the first line. This line appears similar to the
following:

<?xml version=”1.0”?>

The file should begin with a <rubberstamp> tag.

3. Save your changes.

8.4.3 Creating a rubber stamp
Rubber stamps are comprised of image files or XML-structured data stored as TXT
files and only available for use after a system administrator creates and configures
them in Web Access. Subsequently, you can add either text or image-based rubber
stamps.

Notes

• Only users with Administrator privileges can create rubber stamps.

• If you want to use a rubber stamp from the Document Manager desktop
application, you must modify the file to be compliant before it can be added
in Web Access. For more information on modifying the rubber stamp, see
“Preparing a rubber stamp file for Web Access” on page 93.

To create a rubber stamp in Web Access:

1. In the Applications list, click _RSTAMP.

2. In the _RSTAMP – Rubber Stamp Application pane, click New Document.

3. In the New Document pane, click Add Page, .

4. In the Add New Page dialog box, click Choose Files.

5. Browse the file system and locate the rubber stamp file to upload.
When uploading a text-based rubber stamp, you must use a TXT file.
When uploading an image-based rubber stamp, you must use a BMP, GIF, JPG,
PCX, PNG, TIF, or TGA file.
Select the file and click Open.
In the Add New Page dialog box that reappears, ensure Insert After is selected
in the list.
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6. Click Upload.

If you uploaded a text-based rubber stamp, the XML contents of the uploaded
rubber stamp are displayed in the viewer.

If you uploaded an image-based rubber stamp, the image is displayed in the
viewer.

7. In the default index value box, type a name for the rubber stamp.

8. Click Save.

Note: To enable the rubber stamp for use in other applications, you must log
out and then log in again to refresh the lists.

8.5 Redaction templates
Redaction templates allow you to apply a saved shape redaction style on existing
annotations in the Document Viewer of Web Access. You can create up to three
redaction templates.

Creating a new Redaction annotation

1. From the list of applications, select the required application.

2. Click New Document.

3. In the Add New Page dialog box, click Choose Files and select any image PDF
document.

Note: Text PDFs are not supported.

4. Open the supported document in Document Viewer.

5. Select any shape annotation and add it as a redaction.

For more information, see “Configuring annotation properties” on page 88.

6. Draw the shape annotation with the background color filled.

7. Select the shape annotation, add the line width and color options in the
Annotation Properties dialog box.

Note: The full title of the Annotation Properties dialog box depends on the
shape annotation you selected.

8. Select the Redaction check box and click SAVE TO TEMPLATE.

9. Double-click the annotation.

10. In the Save redaction style to template dialog box, enter a template name and
click OK to save the redaction color and border width.

You can select any shape annotation and apply the saved template properties.
You can save a maximum of three templates.
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11. Close the Annotation Properties dialog box.

Using a saved annotation

1. Draw a shape annotation in the viewer.

2. Select the new annotation and, on the Annotation toolbar, click the Redaction
Templates button .

3. In the Select a redaction template from the list dialog box, select a previously
saved template.

4. Click OK to apply the saved redaction color and border width to the new
annotation.

8.6 Hiding annotations
For security reasons, you might want to hide annotations when you display, print,
email, or export annotated documents. When you complete one or all of these
activities, you might want to reveal the hidden annotations.

Only users with appropriate privileges and appropriate annotation group options
can hide annotations. The annotation group to which you are assigned must be set
as the default for you to be able to use the annotation features. Users with
annotation groups options can hide only those annotations that are assigned to the
group.

Note: For information about assigning privileges to a user profile, see the
OpenText AppEnhancer Administration Guide.

To hide annotations when Click

Viewing a document The Show/Hide icon on the Actions toolbar.
To display the hidden annotations, click the
Show/Hide icon again.

Printing a document Print on the menu bar. To hide the
annotations, select the Hide Annotation
option in the Print dialog box. Then click
Print

Emailing a document EMAIL on the menu bar. To hide the
annotations, select the Hide Annotation
option in the Mail Document dialog box.
Then click Send

Exporting a document Export on the menu bar. To hide the
annotations, select the Hide Annotation
option in the Export Document dialog box.
Then click Export

For more information, see “Exporting
selected COLD documents” on page 55.
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8.7 Modifying annotations
You can modify the properties of an annotation after it has been added or saved on
an image or a document. Only users with appropriate privileges can modify
annotations.

Note: If you have created and saved annotations while the CM security
provider was in use and you are now using the Windows security provider,
you must have both the Global Annotations and Edit Annotations privileges
assigned to your profile before changing the security provider.

To Click the Select icon on the Annotation
toolbar and

Select annotations Click the annotation.

Change the location of annotations Click the annotation and then drag the
annotation to a new location. To move
multiple annotations, press the Ctrl key and
then click the relevant annotations.

Resize any type of annotation Select the annotation, and then use the
mouse pointer to resize the annotation.

Modify annotations Select the annotation, right-mouse click, and
then select Properties.

The Annotation Properties or the Edit Text
Annotation dialog box (depending on the
annotation type that you are modifying),
displays the properties associated with the
annotation. Changes the properties of the
annotation as applicable.

Note: The dialog boxes also provide
information about annotation. If the
annotation is assigned to an annotation
group, the name of the annotation
group is provided. If the AppEnhancer
system uses the Windows security
provider, the domain name is also
provided along with each username.

After you modify annotations, click the Save Changes icon on the Actions toolbar.
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8.8 Deleting annotations
If you have the appropriate privileges, you can remove annotations from a page by
deleting them. To remove an annotation, select the annotation, right-click, and then
select Delete.

Note: If you have created and saved the annotations while the CM security
provider was in use and you are now using the Windows security provider,
you must have both the Global Annotations and Edit Annotations privileges
assigned to your profile before to the change in the security provider.

8.9 Managing annotation security
You can manage the security for AppEnhancer rubber stamp annotations in
AppEnhancer Web Access or AppEnhancer Document Manager. All other
annotation security functions are performed in AppEnhancer Administrator and
AppEnhancer Document Manager.

For more information, see the OpenText AppEnhancer Administration Guide.

8.9.1 Configuring rubber stamp security
If you are an AppEnhancer system administrator and have access to the _RSTAMP
application, you can edit the name, application, user or group access, and
description for rubber stamp annotations.

Note: You must have the Administrator privilege in your AppEnhancer
security profile to be able to access the _RSTAMP application.

To configure rubber stamp security:

1. From the list of applications, select _RSTAMP.

2. Click New Query.

• To search for a particular rubber stamp, add the search criteria to the index
fields.

• To view all available rubber stamps, do not specify any search criteria.

3. Click Run.

4. From the Query Results page, select the rubber stamp that you want to
configure, and then click Open on the context menu.

The document opens in the Document Viewer in the index view.

5. Click MODIFY and change the index fields as needed. This table describes each
index field and its effect on rubber stamp annotations.
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Index field Description

NAME A name for the annotation, the way it
must appear in the Name column of the
Select a rubber stamp from the list dialog
box. The actual content of rubber stamps
must be changed within AppEnhancer
Document Manager.

DESC A description for the annotation, the way
it must appear in the Description column
of the Select a rubber stamp from the list
dialog box.

APP The name of the specific application for
which the rubber stamp is created. If you
do not specify a name, the rubber stamp is
used in all applications. To enable global
usage, the AppEnhancer system
administrator must configure the APP
field as non-required within the _RSTAMP
application.

For information about modifying
applications, see the OpenText
AppEnhancer Administration Guide.

USER The names of the individual users or user
groups who can use the rubber stamp. Do
not specify the names if you want to allow
all users to access the rubber stamp. To
enable global usage, the AppEnhancer
system administrator must configure the
USER field as non-required within the
_RSTAMP application.

For information about modifying
applications, see the OpenText
AppEnhancer Administration Guide.

DOMAIN If the underlying AppEnhancer system
uses the Windows security provider,
indicates the name of the domain
associated with this rubber stamp. Do not
specify a value of if you want to make the
rubber stamp available to all domains. If
the AppEnhancer system uses the CM
security provider, leave this field blank.

For more information about security
providers, see the OpenText AppEnhancer
Installation Guide.

6. Click SAVE.
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Chapter 9

Working with Document Retention

AppEnhancer Software Retention Management is a licensed feature that protects
documents from loss, whether accidental or malicious. This feature also ensures that
documents are retained in an AppEnhancer repository for a specified period, in
accordance with legal, regulatory, fiscal, and operational requirements.

Notes

• The retention administrator creates retention policies that determine the
duration for which documents must remain in the AppEnhancer repository
and also manages documents under retention.

• You cannot file documents that are imported from AppEnhancer Reports
Management for retention in AppEnhancer Web Access.

• You cannot file a document for retention if it is checked out.

9.1 Retention concepts
AppEnhancer Web Access displays the retention options if your application is
configured for AppEnhancer software retention and Retention Administrator or
Retention User permission is granted to your user account.

Note: You do not need Retention Administrator or Retention User permission
to query a retention-enabled application for documents by retention status or
by retention hold status. To search for documents under retention, select an
option from the Show list box in the search page.

You cannot modify or delete the documents that are filed for retention until the
expiry of the retention period. After the end of the retention period, the retention
administrator determines whether to remove the document from the AppEnhancer
repository or to retain the document in the repository as a writable document.

Documents under retention are in the read-only mode. You cannot check the
documents out of the AppEnhancer repository to change, however, you can use
these AppEnhancer features to create a new copy of the document:

• The Copy or Move Pages feature. For more information, see “Moving or copying
document pages” on page 73.

• The Export and Import features. For more information, see “Exporting selected
COLD documents” on page 55 and “Adding pages to batches” on page 35.

Note: You can modify a copy of a document because retention configuration
information that is associated with the original document is not preserved in
the copy.
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AppEnhancer also provides a retention hold feature, sometimes called a litigation
hold, that lets you further protect a document that is under retention. A retention
hold prevents a file from being deleted from the AppEnhancer repository, even if its
retention period has expired. In effect, a hold acts like an indefinite retention of a
file. Users cannot delete an expired file until the hold is removed

9.2 Filing documents for retention
You must be granted Retention Administrator or Retention User permission to file
documents for retention.

1. From the Query Results page, select the document or documents that you want
to file for retention.

2. Click Retention > File For Retention on the menu bar.

In the Retention dialog box, you can view the ID of the selected documents and
the retention expiration date of the default policy.

3. Select a retention policy from the list box.

The expiration date of the retention policy changes according to the policy that
you select.

Note: If multiple retention policies have been configured, you can select a
policy other than the default value only if Override Default Retention
Policy is selected in the Retention Management Configuration Utility
wizard or your user account has the Retention Administrator permission.

4. To apply the retention setting to previous versions of the document, select File
all previous document revisions.

The document along with its previous versions are added to the retention table.

5. Click FILE.

• If you have filed the latest version of a document for retention, the status of
the document changes to indicate that it is now the latest version under
retention.

• If you have filed a previous version of a document for retention, the status of
the document changes to indicate that it is now the previous version under
retention.

The retention icons in the Query Results page identify the document status.

Icon Description

Specifies that the latest version of the
document is under retention
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Icon Description

Specifies that the previous version of the
document is under retention

9.3 Managing documents under retention
While a document is under retention, you can change the retention period or place a
retention hold. A retention hold status overwrites the retention period. You must be
granted Retention Administrator permission to manage documents that are under
retention.

1. From the Query Results page, select a document or documents under retention.

2. If you want to extend the retention period, click Retention > Change Retention
Period and select a new retention policy.

3. If you want to place a retention hold, click Retention > Place Retention Hold
and type a hold label for the selected documents.

4. If you want to remove a retention hold, click Retention > Remove Retention
Hold.

The retention icons in the Query Results page identify the document status.

Icon Description

Specifies that the latest version of the
document is on retention hold.

Specifies that the previous version of the
document is on retention hold.

9.4 Retention Administration wizard
The Retention Administration wizard enables you to manage multiple documents in
a retention-enabled application. You must be granted Retention Administrator
permission to use the wizard.

1. From the list of applications, select the application for which you want to
manage documents.

Note: If you select an application that has no saved queries, the New
Search page appears. Either run a query or cancel the New Search page to
have access to links or to the main panel of the view, both of which enable
you to perform document, batch, and query operations.

2. Click the  icon in the toolbar and select Retention Administration.

3. In the SELECT MODE page of the wizard, specify an action that you want to
perform.
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Option Description

Dispose of documents from the
application

Permanently deletes the contents of
selected documents from the application.
The disposed content is not recoverable.

Remove hold on retention hold documents Returns documents that are on retention
hold status back to under retention status.

Clear retention setting on documents
under retention that have expired

Resets the status of expired documents so
that they are no longer under retention
and can again be edited and deleted.

Dispose documents under retention that
have expired

Permanently deletes the contents of
documents with an expired retention
period from the application. The disposed
content is not recoverable.

Export and dispose of documents under
retention that have expired

Exports and then deletes the contents of
documents with an expired retention
period from the application. The disposed
content is not recoverable. Options
include:

• The UNC path to save the exported
files to

• Specifies whether to delete the contents
of the selected documents permanently
after export. The option is enabled by
default.

• Specifies whether to generate the Index
Image Import script file for exported
documents. The option is disabled by
default.

4. In the SEARCH DOCUMENTS page of the wizard, specify the query criteria to
search for the documents on which you want to perform the operation.

Some query options are overridden and set to a fixed value.

If you selected: Then the query criteria is set to:

Dispose of documents from application All documents, except for those
documents on retention

Remove hold on retention hold documents Only documents that are on retention hold

All other options Only documents that are on retention, but
are not on retention hold

5. In the SELECT DOCUMENTS page of the wizard, review the query results and
specify selected documents or all documents to process.

6. In the PROCESS RESULT page of the wizard, click either:

• FINISH to return to the application page
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• RESTART to return to the SELECT MODE page of the wizard
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Chapter 10

Using add-ins

10.1 AppEnhancer Office 365 add-in
You can use the AppEnhancer Office 365 add-in to open AppEnhancer Web Access
documents in Office 365 applications and directly import documents from Office 365
applications into AppEnhancer Web Access.

The add-in supports the following functions:

Office application Functionality

Microsoft Word • Import documents from Word into
AppEnhancer Web Access

• Open documents from AppEnhancer
Web Access in Word

Microsoft Excel • Import documents from Excel into
AppEnhancer Web Access

Microsoft PowerPoint • Import documents from PowerPoint into
AppEnhancer Web Access

Microsoft Outlook • Import email messages from Outlook into
AppEnhancer Web Access as a
single .eml file

• Import email messages from Outlook into
AppEnhancer Web Access as separate
files

• Attach documents from AppEnhancer
Web Access to email messages in Outlook

Note: When using the AppEnhancer Office 365 add-in in a desktop client,
some options such as Print Document or Download Foreign File might not be
available. This is a known limitation with add-ins in the desktop client. If you
encounter this issue, it is recommended that you use Office on the web to
complete these tasks.
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10.1.1 Configuring the Office 365 add-ins
To configure the Word Office 365 add-in, you must complete the following tasks:

• Download the add-in manifest files

• Configure the AppEnhancer Web Access settings

• Enabling SSL protocol in IIS Manager

• Configure the certificates

• Enabling Office 365 add-ins

Before continuing, it is recommended you review “Known Issues for the Office 365
add-ins” on page 120.

10.1.1.1 Downloading the Add-in Manifest Files

You must download the Office 365 add-in manifest files to your machine:

• AEExcelAddIn.xml

• AEOutlookAddIn.xml

• AEPowerPointAddIn.xml

• AEWordAddIn.xml

The files can be found in either of the following locations:

• C:\inetpub\wwwroot\AppEnhancer\Office365Manifest\

• AppEnhancer\AE\CMDev\XsNet\Web\UI\WebAccessUI\Office365Manifest

10.1.1.2 Configuring the AppEnhancer Web Access Settings

AppEnhancer Web Access uses X-Frame-Options to mitigate clickjacking attacks by
ensuring that Web Access content is not embedded into other sites. Before you can
use AppEnhancer Web Access with Office, you must disable this security setting.
Then you must modify some configuration settings to ensure the console behaves as
expected with cookies coming from the same site.

1. Navigate to the AppEnhancer folder and open the web.config file for editing.

2. Within the file, locate the <httpProtocol> section and comment out the <add 
name=”X-Frame-Options” value=”sameorigin” /> line.

3. Next, you must configure the same site cookie settings. Note that you must
have .NET Framework version 4.8. or later installed on your machine.

4. Return to the web.config file for editing and make the following changes in the
file:

• <sessionState cookieName="ASP.NET_SessionId_Wx" 
cookieSameSite="None"/>

Chapter 10   Using add-ins

106 OpenText™ AppEnhancer Web Access EAXCORE230400-UGW-EN-1



• <httpCookies httpOnlyCookies="true" sameSite="None" 
requireSSL="true"/>

5. Also in the web.config file, you must also enable support for older browsers by
ensuring that the <add key=”SameSiteSupportForOldBrowsers” value=”true”/>
line is set to true.

6. Save the changes.

10.1.1.3 Enabling SSL protocol in Microsoft IIS Manager

You must enable ensure the AppEnhancer site is using SSL protocol for HTTPS by
configuring the properties in Microsoft IIS Manager. In IIS Manager, access the SSL
Settings for AppEnhancer and select the Require SSL option.

For more information about how to configure the SSL settings in the Microsoft IIS
Manager, see Microsoft IIS online help.

10.1.1.4 Configuring the Certificates

You must ensure that your server certificates are properly assigned and configured
to work with the Office 365 add-ins. The configuration of multiple certificates needs
to be verified. To check your certificates:

1. In the IIS Manager, locate the properties for AppEnhancer’s Server Certificates
and ensure a self-signed certificate is assigned to AppEnhancer and that
Certificate Store is set to WebHosting.

For more information on checking server certificates in the Microsoft IIS
Manager, see Microsoft IIS online help.

2. Next, you must ensure that the certificate is installed correctly as a trusted
certificate.

a. At a command prompt, type mmc and press Enter.

b. In the Microsoft Management Console instance for Console1, navigate to
File > Add/Remove Snap-in.

c. In the Add or Remove Snap-ins dialog box, select Certificates in the
Available snap-ins pane and then click Add.

d. In the Certificates snap-in dialog box that appears, select Computer
Account and then click Next.

e. In the Select Computer dialog box, keep the default settings and then click
Finish.

f. The Add or Remove Snap-ins dialog box reappears. Click OK.

The main Microsoft Management Console screen reappears.

3. Next, you must ensure that the created certificate exists for your server
connection. In the Console Root pane, go to Trusted Root Certification
Authorities > Certificates.
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4. In the list of certificates, ensure a certificate has been Issued To your server.

5. If a certificate does not exist for your server, you must export one.

a. In the Console Root pane, navigate to Web Hosting > Certificates.

b. In the list of certificates, locate the appropriate certificate for your server,
right-click the certificate and from the context menu that appears, select All
Tasks > Export.

c. In the Certificate Export Wizard that appears, follow the instructions to
run through the wizard while keeping the default settings.

d. On the File to Export screen, you must enter a File name for the certificate
file you want to export.

e. When you are finished, click Finish.

6. Then, you must continue verifying that the certificates are installed correctly.

a. In Internet Explorer, navigate to Tools > Internet options.

b. In the Internet Options dialog box, switch to the Content tab and click
Certificates.

c. In the Certificates dialog box, switch to the Trusted Root Certification
Authorities tab.

d. In the list of certificates, ensure a certificate has been Issued To your server.

7. If a certificate is not listed for your server, you must import one.

a. Remaining in the Certificates dialog box’s Trusted Root Certification
Authorities tab, click Import.

b. In the Certificate Import Wizard, click Browse to navigate to the file path
location of the previously exported certificate.

c. On the Certificate Store screen, change the Certificate store value from
Personal to Trusted Root Certification Authorities.

d. When you are finished, click Finish.

10.1.1.5 Enabling Office 365 add-ins

Before you can use the Office 365 add-ins, you must manually enable them in the
online versions of Word, Excel, PowerPoint, and Outlook.
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10.1.1.5.1 Enabling the Office 365 add-in for Word, Excel, and PowerPoint Online

Before making configuration changes in Word, Excel, or PowerPoint, you must
perform some preliminary steps in your preferred browser:

• All browsers: Clear all caches and browser history.

• If you are using Google Chrome version 89 or earlier:

1. In Chrome, type chrome://flags in the address bar and press Enter.

2. On the Experiments page, locate the following features and set them to
Disabled:

– SameSite by default cookies

– Enable removing SameSite=None cookies

– Allow invalid certificates for resources loaded from localhost

• If you are using Google Chrome, version 90 or later:

1. In Chrome, type chrome://flags in the address bar and press Enter.

2. On the Experiments page, locate the allow-insecure-localhost feature and
set it to Enabled.

3. Lastly, ensure you are running the most recent Windows updates.

Once your browser is configured, you can enable the add-in for Word, Excel, or
PowerPoint.

Note: The instructions below illustrate enabling the add-ins in Word Online,
but the procedure can be similarly applied to Excel and PowerPoint.

1. In your preferred browser, open AppEnhancer Web Access.

2. Verify that a warning about your connection not being private or secure
appears. (The exact wording of the message varies depending on your browser.)
The Office add-in only works when this warning message is shown.

If a warning like this does not appear, then you can try clearing the browser’s
cache or using another browser.
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Figure 10-1: Sample connection not private warning message from Google
Chrome

3. Click Proceed to continue with the connection.

4. Click No need to login to AppEnhancer.

5. Next, you must install the add-in. In your preferred browser, open Word
Online.

6. In the Word Online toolbar, go to Insert > Add-ins.

7. In the Office Add-ins dialog box, click Upload My Add-in.

8. Browse to the file path location of the AEWordAddIn.xml add-in manifest file,
select the file, and then click Upload. (When uploading the add-ins for Excel or
PowerPoint, ensure you are using their respective add-in manifest file.)

After the upload completes, you are returned to Word Online.

With the add-in installed, to launch the Office add-in, in the Word Online toolbar go
to Home > AE WebAccess.
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10.1.1.5.2 Enabling the Office 365 add-in for Outlook Online

To enable the Office 365 add-in for Outlook Online:

1. Go to C:\inetpub\wwwroot\AppEnhancer\Office365Manifest and open the
AEOutlookAddIn.xml file for editing.

2. Within the file, locate the <IconURL> tag and in the DefaultValue, replace
localhost with your local server address.

3. When you are finished, save your changes.

4. Open your web.config file for editing.

5. Within the file, locate the X-Frame-Options property and comment out the line.
The section should appear similar to:

<httpProtocol>

     <customHeaders>

          <!--<add name=”X-Frame-Options” value=”sameorigin” />-->

     </customHeaders>

</httpProtocol>

6. Next, you must configure the cross-site cookie settings. Locate the following
lines and make sure the property values match the following:

<!-- To allow cross-site cookie use, for instance, CDK or 
Office add-in which make use of iframe, cookieSameSite="None" 
must be used in system.web/sessionState-->
<sessionState cookieName=”ASP.NET_SessionId_Wx” 
cookieSameSite=”None”/>
<!-- To allow cross-site cookie use, for instance, CDK or 
Office add-in which make use of iframe, sameSite="None" 
requireSSL="true" must be used in system.web/httpCookies-->
<httpCookies httpOnlyCookies=”true” sameSite=”None” 
requireSSL=”true”/>

7. When you are finished, save your changes.

8. Next, you must install the add-in. In your preferred browser, open Outlook
Online.

9. In Outlook Online, click New Message to create a new email. In the message
pane, add some text to the subject and email body.

10. Click More options, , and from the menu that appears, click Get Add-ins.

11. In the Add-Ins for Outlook dialog box, click My Add-ins.

12. On the My Add-ins pane, click Add a custom add-in and then Add from File.

13. Browse to the file path location of the AEOutlookAddIn.xml add-in manifest file,
select the file, and then click Open.
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14. You can verify that the add-in has been successfully installed by checking
whether AE Outlook Add-in has been added under More options, .

With the add-in installed, to launch the Outlook add-in, in the Outlook Online
toolbar go to More options, , and select AE Outlook Add-in.

10.1.2 Configuring AppEnhancer Web Access with Office
Online Server
To use the Office 365 add-ins, you must configure your AppEnhancer Web Access
machine to integrate with Microsoft Office Online Server (OOS). When integrating
AppEnhancer with OOS, you can choose from either HTTP or HTTPS protocols. It is
recommended new users begin with HTTP protocol and when they become more
familiar with the basics, then move to HTTPS protocol.

10.1.2.1 Configuring AppEnhancer Web Access Using HTTP Protocol

To configure AppEnhancer Web Access settings for integrations with Office Online
Server using HTTP protocol, you must complete the following tasks:

• Configure AppEnhancer Web Access settings

• Check proxy server settings

• Verify Office Online Server installation for HTTP users

• Upload a test document

10.1.2.1.1 Configuring AppEnhancer Web Access settings

To set up AppEnhancer Web Access for the Office Online Server integration:

1. On your AppEnhancer machine, log in to Web Access.

2. Navigate to User Settings.

3. On the User Settings screen, open the Document View node and select Open
Office Documents with Office Online Server.

4. Next, locate your web.config file, and open the file for editing.

5. Within the file, locate the OOSUrl property and modify the value with the IP
address or server name of the machine where OOS is installed. The code
appears similar to:

<add key=”OOSUrl” value=”<OOS_server_name>”/>

6. Save your changes.
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10.1.2.1.2 Checking proxy server settings

If your AppEnhancer instance is installed on a proxy server, you must ensure that
the LAN settings are configured to bypass the proxy server.

1. In Internet Explorer, navigate to Tools > Internet options.

2. In the Internet Options dialog box, switch to the Connections tab and click
LAN Settings.

3. In the Local Area Network (LAN) Settings dialog box, in the Proxy server area,
select the Use a proxy server for your LAN (These settings will not apply to
dial-up or VPN connections) and Bypass proxy server for local addresses
checkboxes.

4. Click Advanced.

5. In the Proxy Settings dialog box, add all IP addresses that should not be used
by the proxy server. One of these must be the IP address for OOS.

10.1.2.1.3 Verifying Office Online Server installation for HTTP users

Next, you must verify that Office Online Server is installed and configured correctly
as well as verify that your AppEnhancer machine can send and receive requests
from the OOS machine.

1. Using the machine where AppEnhancer is installed, in your preferred browser
go to the http://<OOS_server_name>/hosting/discovery page.
<OOS_server_name> must be replaced with the IP address or server name of the
machine where OOS is installed.

2. If Office Online Server is functioning normally, a Web Application Open
Platform Interface Protocol (WOPI) discovery XML file appears in the browser.
The beginning of the XML file should appear similar to the following:

<?xml version=”1.0” encoding=”utf-8> ?>
- <wopi-discovery>
- <net-zone name=”internal-http”>
- <app name=”Excel”
favIconUrl=http://servername/x/_layouts/images/FavIcon_Excel.ico 
checkLicense=”true”>
<action name="view" ext="ods" default="true" urlsrc="http://servername/x/_layouts/
xlviewerinternal.aspx?<ui=UI_LLCC&amp;><rs=DC_LLCC&amp;>" />
<action name="view" ext="xls" default="true" urlsrc="http://servername/x/_layouts/
xlviewerinternal.aspx?<ui=UI_LLCC&amp;><rs=DC_LLCC&amp;>" />
<action name="view" ext="xlsb" default="true" urlsrc="http://servername/x/
_layouts/xlviewerinternal.aspx?<ui=UI_LLCC&amp;><rs=DC_LLCC&amp;>" />
<action name="view" ext="xlsm" default="true" urlsrc="http://servername/x/
_layouts/xlviewerinternal.aspx?<ui=UI_LLCC&amp;><rs=DC_LLCC&amp;>" />
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10.1.2.1.4 Uploading a test document

Lastly, you should verify whether you can make a connection and upload a
document.

1. Open AppEnhancer Web Access.

2. Upload a Word document (ensure that the file has the .docx extension).

3. In Word Online, verify that Office Online features have been added to the
menu and that Web Access can display the Word document.

10.1.2.2 Configuring AppEnhancer Web Access Using HTTPS Protocol

To configure AppEnhancer Web Access settings for integrations with Office Online
Server using HTTPS protocol, you must complete the following tasks:

• Configure AppEnhancer Web Access settings

• Import and configure certificates

• Check proxy server settings

• Verify Office Online Server installation

• Upload a test document

10.1.2.2.1 Configuring AppEnhancer Web Access settings

To set up AppEnhancer Web Access for the Office Online Server integration:

1. On your AppEnhancer machine, log in to Web Access.

2. Navigate to User Settings.

3. On the User Settings screen, open the Document View node and select Open
Office Documents with Office Online Server.

4. Next, locate your web.config file, and open the file for editing.

5. Within the file, locate the OOSUrl property and modify the value with the IP
address or server name of the machine where OOS is installed.

<add key=”OOSUrl” value=”<OOS_server_name>”/>

6. Additionally, you must insert an additional line of code to the web.config file.
Below the line with the OOSUrl property, add the following line:

<add key="UriSchemeForO365FileAccess" value="http" />

7. Save your changes.
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10.1.2.2.2 Importing and Configuring Certificates

Next, you must create the required self-signed certificates; one for AppEnhancer
Web Access and one for the OOS machine. Self-signed certificates can be generated
through many different applications. Using your preferred tool, generate self-signed
certificates for each machine. (For more information on generating self-signed
certificates, see the documentation for your preferred application.)

Before continuing, ensure that you have exported copies of the self-signed
certificates you created for AppEnhancer Web Access and OOS because you must
import both certificates as trusted certificates to both of your machines.

To import the certificates:

1. At a command prompt, type mmc and press Enter.

2. In the Microsoft Management Console instance for Console1, navigate to File >
Add/Remove Snap-in.

3. In the Add or Remove Snap-ins dialog box, select Certificates in the Available
snap-ins pane and then click Add.

4. In the Certificates snap-in dialog box that appears, select Computer Account
and then click Next.

5. In the Select Computer dialog box, keep the default settings and then click
Finish.

6. The Add or Remove Snap-ins dialog box reappears. Click OK to close it.

7. Next, you must import the certificates as trusted root certification authorities. In
the Console Root pane, go to Certificates (Local Computer) > Trusted Root
Certification Authorities > Certificates.

8. Right-click Certificates and from the context menu that appears, select All
Tasks > Import.

9. Use the Certificate Import Wizard to import each of your certificates.

10. Repeat steps 2-9 for both certificates on both of your machines.

10.1.2.2.3 Checking proxy server settings

If your AppEnhancer instance is installed on a proxy server, you must ensure that
the LAN settings are configured to bypass the proxy server.

1. In Internet Explorer, navigate to Tools > Internet options.

2. In the Internet Options dialog box, switch to the Connections tab and click
LAN Settings.

3. In the Local Area Network (LAN) Settings dialog box, in the Proxy server area,
select the Use a proxy server for your LAN (These settings will not apply to
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dial-up or VPN connections) and Bypass proxy server for local addresses
checkboxes.

4. Click Advanced.

5. In the Proxy Settings dialog box, add all IP addresses that should not be used
by the proxy server. One of these must be the IP address for OOS.

10.1.2.2.4 Verifying Office Online Server installation for HTTPS users

Next, you must verify that Office Online Server is installed and configured correctly
as well as verify that your AppEnhancer machine can send and receive requests
from the OOS machine.

1. On your AppEnhancer Web Access machine, open your preferred browser and
clear the cache and browser history.

2. In the browser, go to the http://<OOS_server_name>/hosting/discovery page.
<OOS_server_name> must be replaced with the IP address or server name of the
machine where OOS is installed.

3. If Office Online Server is functioning normally, a warning about your
connection not being private or secure appears. (The exact wording of the
message varies depending on your browser.) A connection with the OOS
machine only works when this warning message is shown.

If a warning like this does not appear, then you can try clearing the browser’s
cache or using another browser.
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Figure 10-2: Connection is not private

4. Click Proceed to continue with the connection.

5. If Office Online Server is functioning normally, a Web Application Open
Platform Interface Protocol (WOPI) discovery XML file appears in the browser.
The XML file should appear similar to the following:

<?xml version=”1.0” encoding=”utf-8> ?>
<wopi-discovery>
  <net-zone name=”internal-http”>
    <app name="Excel" favIconUrl="http://10.9.77.91/x/_layouts/resources/
FavIcon_Excel.ico" bootstrapperUrl="http://oos2016/x/_layouts/app_scripts/excel-
boot.min.js" checkLicense="true">
      <action name="view" ext="csv" default="true" urlsrc="http://10.9.77.91/x/
_layouts/xlviewerinternal.aspx?
<ui=UI_LLCC&><rs=DC_LLCC&><dchat=DISABLE_CHAT&><hid=HOST_SESSION_ID&><IsLicensedUs
er=BUSINESS_USER&><actnavid=ACTIVITY_NAVIGATION_ID&>"/>
      <action name="view" ext="ods" default="true" urlsrc="http://10.9.77.91/x/
_layouts/xlviewerinternal.aspx?
<ui=UI_LLCC&><rs=DC_LLCC&><dchat=DISABLE_CHAT&><hid=HOST_SESSION_ID&><IsLicensedUs
er=BUSINESS_USER&><actnavid=ACTIVITY_NAVIGATION_ID&>"/>
      <action name="view" ext="xls" default="true" urlsrc="http://10.9.77.91/x/
_layouts/xlviewerinternal.aspx?
<ui=UI_LLCC&><rs=DC_LLCC&><dchat=DISABLE_CHAT&><hid=HOST_SESSION_ID&><IsLicensedUs
er=BUSINESS_USER&><actnavid=ACTIVITY_NAVIGATION_ID&>"/>
      <action name="view" ext="xlsb" default="true" urlsrc="http://10.9.77.91/x/
_layouts/xlviewerinternal.aspx?
<ui=UI_LLCC&><rs=DC_LLCC&><dchat=DISABLE_CHAT&><hid=HOST_SESSION_ID&><IsLicensedUs
er=BUSINESS_USER&><actnavid=ACTIVITY_NAVIGATION_ID&>"/>
      <action name="view" ext="xlsm" default="true" urlsrc="http://10.9.77.91/x/
_layouts/xlviewerinternal.aspx?
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<ui=UI_LLCC&><rs=DC_LLCC&><dchat=DISABLE_CHAT&><hid=HOST_SESSION_ID&><IsLicensedUs
er=BUSINESS_USER&><actnavid=ACTIVITY_NAVIGATION_ID&>"/>
      <action name="view" ext="xlsx" default="true" urlsrc="http://10.9.77.91/x/
_layouts/xlviewerinternal.aspx?
<ui=UI_LLCC&><rs=DC_LLCC&><dchat=DISABLE_CHAT&><hid=HOST_SESSION_ID&><IsLicensedUs
er=BUSINESS_USER&><actnavid=ACTIVITY_NAVIGATION_ID&>"/>
      <action name="edit" ext="ods" requires="update" urlsrc="http://10.9.77.91/x/
_layouts/xlviewerinternal.aspx?
edit=1&<ui=UI_LLCC&><rs=DC_LLCC&><dchat=DISABLE_CHAT&><hid=HOST_SESSION_ID&><IsLic
ensedUser=BUSINESS_USER&><actnavid=ACTIVITY_NAVIGATION_ID&>"/>
      <action name="edit" ext="xlsb" requires="update" urlsrc="http://
10.9.77.91/x/_layouts/xlviewerinternal.aspx?
edit=1&<ui=UI_LLCC&><rs=DC_LLCC&><dchat=DISABLE_CHAT&><hid=HOST_SESSION_ID&><IsLic
ensedUser=BUSINESS_USER&><actnavid=ACTIVITY_NAVIGATION_ID&>"/>
      <action name="edit" ext="xlsm" requires="update" urlsrc="http://
10.9.77.91/x/_layouts/xlviewerinternal.aspx?
edit=1&<ui=UI_LLCC&><rs=DC_LLCC&><dchat=DISABLE_CHAT&><hid=HOST_SESSION_ID&><IsLic
ensedUser=BUSINESS_USER&><actnavid=ACTIVITY_NAVIGATION_ID&>"/>
      <action name="edit" ext="xlsx" requires="update" urlsrc="http://
10.9.77.91/x/_layouts/xlviewerinternal.aspx?
edit=1&<ui=UI_LLCC&><rs=DC_LLCC&><dchat=DISABLE_CHAT&><hid=HOST_SESSION_ID&><IsLic
ensedUser=BUSINESS_USER&><actnavid=ACTIVITY_NAVIGATION_ID&>"/>

10.1.2.2.5 Uploading a test document

Lastly, you should verify whether you can make a connection and upload a
document.

1. Open AppEnhancer Web Access.

2. Upload a Word document (ensure that the file has the .docx extension).

3. In Word Online, verify that Office Online features have been added to the
menu and that Web Access can display the Word document.

10.1.3 Importing Documents with Office 365 add-in in Word,
Excel, and PowerPoint on the web
To import a document using the Office 365 add-in in Word, Excel, or PowerPoint:

1. In the Word Online toolbar, go to Home > AE WebAccess.

2. In the AE Word Add-in pane that appears, log in.

3. Upon logging in, open the document that you want to import into
AppEnhancer.

4. Click Page > New Page > Import File.

5. Select where you want to add the document. You can choose from Insert
Before, Insert After, or Append.

6. When you have finished making your selections, click Upload.

Note: The instructions above illustrate importing documents from Word
Online, but the procedure can be similarly applied to the online versions of
Excel and PowerPoint.
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10.1.4 Importing Documents with Office 365 add-in in Outlook
on the web
To import a document using the Office 365 add-in in Outlook:

1. In Outlook Online, click More options, , and select AE Outlook Add-in.

2. In the AE Outlook Add-in pane that appears, log in.

3. Upon logging in, open the email you want to import into AppEnhancer.

4. Click Create New Document.

5. Click Page and then select your Import options.

6. Select where you want to add the document. You can choose from Insert
Before, Insert After, or Append.

7. When you have finished making your selections, click Upload.

10.1.5 Setting up the AppEnhancer Office 365 add-in in Word,
Excel, and PowerPoint Desktop Clients
To set up the add-in on a desktop client:

1. Open File Explorer on the Windows computer where you want to host your
add-in and navigate to the parent folder or drive of the folder that you want to
use as your shared folder catalog. Right-click the folder and click Properties.

2. In the Properties dialog window, open the Sharing tab and click Share.

3. In the Network access dialog window, add yourself and any other users and/or
groups with whom you want to share the add-in. You must have Read/Write
permission for this folder. When you are finished, click Share.

Note: When you see a confirmation that your folder is shared, make a note
of the full network path that is displayed immediately after the folder
name. You will need to enter this value as the Catalog Url when
you specify the shared folder as a trusted catalog.

4. Click Done to close the Network access dialog window, and then click Close to
close the Properties dialog window.

5. Open a new document in Excel, Word, or PowerPoint.

6. On the File tab, click Options > Trust Center > Trust Center Settings > Trusted
Add-in Catalogs.

7. In the Catalog Url box, enter the full network path to the folder that
you shared in step 3, and click Add catalog. If you did not note the folder path,
you can find it in the folder's Properties dialog window.
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8. Select the Show in Menu check box for the newly-added item, and then click
OK.

9. Click OK to close the Word Options dialog window.

10. Close and reopen the Office application so that your changes will take effect.

11. Put the manifest XML file of any add-in in the shared folder catalog.

You can download the manifest files by navigating to:

• Word manifest file: AEWordAddIn.xml

• Excel manifest file: AEExcelAddIn.xml

• PowerPoint manifest file: AEPowerPointAddIn.xml

12. In Excel, Word, or PowerPoint, on the Insert tab, click My Add-ins > SHARED
FOLDER.

13. Select the name of the add-in and click OK.

10.1.6 Setting up the AppEnhancer Office 365 add-in in
Outlook
To set up the add-in on a desktop client:

1. In Outlook for Windows, click Get Add-ins > Add-ins > My add-ins.

2. In the Custom add-ins section at the bottom of the dialog window, click Add a
custom add-in > Add from file.

3. Navigate to the manifest file for your custom add-in and install it. Accept all
prompts during the installation.

You can download the manifest file by navigating to:

https://<server-address>/AppEnhancer/Office365Manifest/AEOutlookAddIn.xml

10.1.7 Known Issues for the Office 365 add-ins
There are a few known issues affecting the Office 365 add-ins:

• Multiple add-ins cannot be run simultaneously in Office desktop applications.
Attempting to do so may result in AppEnhancer Web Access encountering issues
with logging in or out.

• When working with Office desktop applications earlier than Office 2019 or Office
365, after logging out from AppEnhancer Web Access, you may need to
manually close the add-in task pane before you can log in again.

• Dialog boxes from AppEnhancer Web Access may not appear as expected in
Office desktop applications, preventing you from completing some tasks. For
example, clicking the Download Foreign File link in AppEnhancer Web Access
may not display the dialog box required to download the file.
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• Auto logout must be turned off in AppEnhancer Web Access.

10.2 Core Signature integration
Core Signature is an electronic signature application that allows employees and
third-party users to sign documents. It has been integrated to seamlessly add this
functionality to AppEnhancer Web Access.

10.2.1 Requirements
This section describes requirements related to the Core Signature integration:

• Configure Core Signature services

Before you can work with Core Signature in AppEnhancer Web Access, make
sure that you have configured the Core Signature services in AppEnhancer
Administrator.

• OT2 Core Signature account

Make sure that you have access to an existing OT2 Core Signature account.

• Template documents

If you want to use the Sign Template Document feature, the template documents
must already exist. You can create and manage your templates on the Templates
page in your OT2 environment.

• Turn off pop-up blockers

Pop-up blockers in browsers can interfere with your ability to use the
AppEnhancer Web Access website if it prohibits a required window from
opening. You can either turn off all pop-up blockers or alternatively, add an
exception for your AppEnhancer Web Access site to prevent it from being
erroneously blocked.

10.2.2 Using Core Signature integration in AppEnhancer Web
Access
Core Signature templates are PDF documents that have been configured with one or
more signers or approvers in the Core Signature account. This account can be
configured in AppEnhancer Administrator, Core Signature Shared Account, or
AppEnhancer User Profile Core Signature account.
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10.2.2.1 Signing a template document

To sign a template document:

1. From the list of applications, select the application for which you want to sign a
template document.

2. Click the  icon in the toolbar and select New Signed Document from
Template.

3. In the Sign Document using Core Signature dialog box, select an existing
Template from the list and then click Select.

4. In the Signers list, choose Placeholder 1 Signer and then click Edit.

5. In the Add Signer dialog box, you must enter a valid email address in the Email
box. Optionally, you can provide a First Name and Last Name for the signer.
The Type is automatically determined by the template and cannot be modified.

When you are finished, click Add.

6. The new signer appears in the Sign Document using Core Signature dialog
box. Make sure that the new Signer is selected.

7. If you have configured a return event, you must choose a Receipt option. For
more information about receipt modes, see “Setting a receipt mode”
on page 123.

8. Click Sign.

10.2.2.2 Signing an existing AppEnhancer document

AppEnhancer documents can be prepared for signing from the Document menu in
AppEnhancer Document Viewer. For documents to be rendered as a PDF, you must
have a Core Signature account configured in AppEnhancer Administrator or use an
AppEnhancer user. When the document PDF is uploaded with the configured
signers, then the Core Signature preparation window for configuring signing
options is launched.

To sign a document using Core Signature:

1. In Document Viewer, click Document > Sign Document.

2. In the Sign Document using Core Signature dialog box, click Add to add a
Signer or Approver to the document.

3. In the Add Signer dialog box, you must enter a valid email address in the Email
box. Optionally, you can provide a First Name and Last Name for the signer.
The Type is automatically determined by the template and cannot be modified.

When you are finished, click Add.

4. The new signer appears in the Sign Document using Core Signature dialog
box. Make sure that the new Signer is selected.
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5. If you have configured a return event, you must choose a Receipt option. For
more information about receipt modes, see “Setting a receipt mode”
on page 123.

6. Click Sign.

10.2.2.3 Configuring the signing process

The document signing process can be customized for your requirements.

You can define whether one or more recipients need to sign the prepared document.
When more than one signer is required, add the users in the order in which the
signatures are required.

10.2.2.4 Specifying the approval type for a document

When sending a document for electronic signature, you can specify the type of
approval required in the Add Signer dialog box. In the Type list, you can choose
from the following options:

• Sign. The signer must add their electronic signature.

• Sign in Person. The signer must add their signature in person.

• Approve. The signer does not need to sign the document but must provide their
approval.

• Notify. The signer does not need to sign but is notified about the document.

• CC. The signer does not need to sign but receives a copy of the document.

Note: The signer does not need to be a Core Signature user to sign the contract
or agreement. Upon a third-party user providing their e-signature, the
document is automatically updated in Core Signature.

10.2.2.5 Setting a receipt mode

When preparing a document for signing using Core Signature, you can configure a
return event in the Sign Document using Core Signature dialog box. In the Receipt
list, you can choose from the following options:

• None. Continues without saving the signed document.

• Append to Document. Saves the signed document by inserting the pages at the
end of the existing document.

• Prepend to Document. Saves the signed document by inserting the pages to the
existing document before page one.

• New revision. Creates a new AppEnhancer document revision with the signed
document.

• Create Batch. Creates a new AppEnhancer batch document with the signed
document.
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10.3 Adjusting maximum transfer sizes
Maximum transfer sizes can be adjusted in the web.config file for Web, REST, and
Web Services programs.

maxRequestLength

Specifies the limit for the input stream buffering threshold, in kilobytes. The limit
can be used to prevent denial of service attacks that are caused, for example, by
many users simultaneously uploading large files to the server. The default value is
10,240 KB, which is the equivalent to 10 MB. Optionally, the value can be expressed
as an int32 attribute.

The maxRequestLength parameter can be found in the system.web/httpRuntime
node in the web.config file. This section of the file has the following appearance:

<system.web>
<!-- maxRequestLength for asp.net, in KB --> 
<httpRuntime maxRequestLength="102400" ></httpRuntime> 
</system.web>

In this code sample, the maxRequestLength parameter is set to 102400 KB, which is
the equivalent to 100 MB.

maxAllowedContentLength

Specifies the request filtering maximum length of content in a request, in bytes. The
default value is 30000000. If request filtering is not enabled, you can ignore this
property. Optionally, the value can be expressed as an uint attribute.

The maxAllowedContentLength parameter can be found in the system.webServer/
security/ requestFiltering/requestLimits node in the web.config file. This
section of the file has the following appearance:

<system.webServer>
<security> 
<requestFiltering> 
<!-- maxAllowedContentLength, for IIS, in bytes --> 
<requestLimits maxAllowedContentLength="104857600" ></requestLimits>
</requestFiltering> 
</security>
</system.webServer>

In this code sample, the maxAllowedContentLength parameter is set to 104857600,
which is equivalent to 100 MB.
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